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Release Notes Summary

Release Highlights
• Live Preview loads preview automatically for available file types.

• Get MS Word Table action includes option to select columns and tags.

• Transcheck options for Current Project links to the Preferences option.

• Machine translation options include Systran PNMT.

• Segment Changes Report includes option to show all segments.

New Features and Improvements
• Implemented Live Preview option to automatically load preview for available file types.

• Implemented options for MS Word table to select columns and tag styles.

• Implemented option to link Project Transcheck with Preferences Transcheck option.

• Added Systran PNMT to machine translation options.

• Added new XLIFF filter Version 2 to default filters list.

• Added cleanup option to overwrite private TU for WFServer TMs in Project Cleanup and Quick Tools
Cleanup.

• Implemented sort of project list, based on languages.

• Implemented option for Segment Changes Report to show all segments.

Fixed Issues
• Fixed issue where Quick Open TXLF did not show the file list in the Current Project view.

• Fixed issue where Go To Segment does not work for segments over 50,000.

• Fixed issue where users cannot add down arrow shortcuts to the shortcut list.

• Fixed issue when editor freezes while scrolling through chained files.

• Fixed issue with bad text selection when switching tag modes.

• Fixed issue with missing temporary file error while closing Modify Project action.

• Fixed issue to show error message when scrolling through open chained files.

• Fixed issue so Quick Open shows message that users are only allowed to open TXLF files.

• Fixed issue with term highlight not working on terms using subscript and superscript.

• Fixed issue with a Find action where there is a bad text selection for a search string.

• Fixed issue with TM Admin sort selecting multiple columns instead of current selection.

• Fixed issue with term selection highlight being longer than actual term selected.

• Fixed issue where Live Preview fails to open in macOS.

• Fixed issue where enabling Stacked View moves the cursor to a different position.

• Fixed issue when Live Preview opens the wrong preview when switching between multiple files.

• Fixed issue when changes are made to the segment results in bad underlining when using Spellcheck.

• Fixed issue with TM Lookup to show actual segment formatting present in the TU.
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• Fixed issue where segmentation does not work for text files.

• Fixed issue so pseudo-translation applies correct characters for Chinese target languages.

• Fixed issue with characters typed in Find text box randomly added to the active segment.

• Fixed issue where target PowerPoint slides text does not retain superscript added to segments.

• Fixed issue when Add Term dialog does not populate both source and target field during text selection.

• Fixed issue where the application is blocked until it is finished for a background cleanup action.

• Fixed issue with inconsistent tag content when copied from the source to the target segment.

• Fixed issue where the Restore original warning shows up only after closing Preferences.

Known Issues
• Sometimes Wordfast app crashes on macOS.

• TXLF Editor columns get hidden when windows display settings are set to 125%.

• Enabling Show Whitespace Characters makes the cursor jump to different location when deleting tags.
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1. About this Guide

Conventions

CONVENTIONS

Typographical
The following table explains the typographical conventions used in this guide.

Bold User interface controls, commands, and keywords in body text.

italic Represents an input field where user input is expected.

<…> Generic parameters that must be replaced by specific code or text.

[…] Generic parameters that are replaced by dynamic text.

CONVENTIONS

Icons
The following table explains the icon conventions used in this guide.

Note:
This icon designates a note or helpful suggestion or reference relating to the surrounding text.

Best Practice:
This icon designates a suggestion for best practice relating to the surrounding text.

Alert:
This icon designates a warning or alert relating to the surrounding text. In this situation, the user
should exercise caution to avoid an undesirable result.
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2. About Wordfast Pro
Wordfast Pro is the latest standalone, multi-platform TM tool designed to address the needs of translators,
language service providers, and multi-national companies. It offers a complete translation environment that stores
your translated content for reuse on future projects, thereby maximizing efficiency, increasing overall consistency
and reducing translation costs.

• Cross-platform compatibility — Browser-based tool runs natively on Windows, Mac, and Linux

• Target-only Live Preview — After translation, provides preview to proofread a target-only version with
layout and formatting

• Segment filtering — Filters segments based on terms, regular expressions, match scores, notes, and
other attributes

• Configure multi-lingual translation projects — Supports translation into multiple target languages and
can send as a single package or separate packages, based on language pairs

• Export and import translation packages — Allows configuration and export of translation packages for
fast, seamless translation management

• Format flexibility — Supports virtually any file format, including MS Office, Adobe InDesign, FrameMaker,
PDF, HTML, XML, SDL Trados Xliff, MemoQ Xliff, and more

• Chain files — Allows combination of multiple files into a single file to improve the consistency of repeated
segments and facilitate file management

• Unlimited TM and glossary access — Accesses an unlimited number of TMs and glossaries
simultaneously and prioritizes as primary or secondary
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3. Get Started
This section provides basic information to get started with Wordfast Pro, a stand-alone desktop application you
install on and access with your local computer.

System Requirements
Supported Operating Systems Microsoft Windows 7+, OSX 10.10+, and Linux 64-bit

Java JRE If not present, Wordfast Pro automatically installs Java JRE during
the application installation process

License and Registration Activation of the full Wordfast Pro installation requires a license and
registration

Minimum System Memory 2GB RAM

Minimum Screen Resolution 1366 x 768 pixels

Installation
Activation of Wordfast Pro requires a license and online or offline registration.

  An unlicensed version of Wordfast Pro working in Demo mode is limited.

• You can only create bilingual projects.

• You can only store up to 500 translation units (TUs) in a Translation Memory. To remove this
restriction, purchase a license and activate the licensed application.

To install Wordfast Pro:

 1. Download the Wordfast Pro Windows Installer Package from http://www.wordfast.com/, based on your
operating system.

 2. In your Downloads folder, double-click the .MSI, .DMG, or .TGZ file to open the Wordfast Pro Setup Wizard.

 3. Complete all steps to align with your configuration, then click Finish.

Wordfast Pro opens in Demo mode, so still requires activation. Refer to Activation.

Activation
You can activate Wordfast Pro with one of two methods: manually or online. Both require an activation key.

To activate Wordfast Pro:

 1. Open Wordfast Pro.

 2. On the Help tab, click License Management.

http://www.wordfast.com/
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 3. On the License Manager dialog, click Online Registration or Manual Registration.

 4. Follow online or manual registration directions.

Option Description

Online Registration Enter the Activation Key and click OK.

Manual Registration 1. Enter the Activation Key and click Generate.
2. Copy this text into an email and send it to the

email address provided.
3. Copy the license file in the return email to the

local disk where you installed Wordfast Pro.
4. On the License Manager dialog and Manual

Registration tab, click browse and select the
license file.

5. Select the license file and click OK.

 5. Restart Wordfast Pro.

The Wordfast Pro activation process is complete.

 
To resolve any license issues, log in to Wordfast Pro and select Support > Hotline.

Licensure
You can install, reinstall, view your current license information, and view WordFast Pro updates on the Help tab.

  Wordfast Pro automatically monitors for updates. If an update is available, you receive notification
right after you open the application.

License Management View the current license and keep track of the days remaining to license expiration.

WordFast Pro Update Use to update your application or Hunspell spelling dictionary.

Start Wordfast Pro
After you have installed and activated Wordfast Pro on your computer, it is ready to use.

To start Wordfast Pro:

 1. Double-click the Wordfast icon on the desktop or from the Start menu to open Wordfast Pro.
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Wordfast Pro opens to the Projects view.

 2. (Optional) Select another view if you have already created a project and are ready to begin translation or
review.

Explore the User Interface
Wordfast Pro allows users to coordinate and automate the translation and review process through an intuitive,
stand-alone user interface.

 
To change to a different view, select one from the Wordfast Pro drop-down menu.

EXPLORE THE USER INTERFACE

Project List View
The Project List view gives you access to a list of your projects. Double-click a project to open the Current
Projects view and access files within the project.
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Item Action

WFP Menu Access user views and user preferences.

Action Button Perform a specific task.

Action Bar Access all action buttons associated with a specific tab.

Project List Access files associated with a specific project.

EXPLORE THE USER INTERFACE

Current Project View
The Current Project view is for projects that contain multiple files. Double-click a file from the list of TXLF files
ready for translation to open the TXLF Editor view and access source and target segments.
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Item Action

WFP Menu Access the Current Project or TXLF Editor views and user preferences.

Menu Tab Access the various tools of the application.

Action Button Perform a specific task.

Action Bar Access all action buttons associated with a specific tab.

Collapsed Items View all available items not visible in the currently sized window.

Language Pair Access the file list associated with a specific source and target language pair.

File Filter Create filter criteria for searching the file list.

File List Access a specific file within the language pair.

File Progress Bar Monitor the percentage of work completed on a file.

Project Progress Bar Monitor the percentage of work completed on a project.

You can use filter criteria and sort files using the provided search options.
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Item Action

Files Create file filter criteria.

Word Count View total file word count.

Translation Status View status of pending, active, delivered, or completed files.

Complete View the file progress bar with completion percentage.

Last Saved View the date for when the user most recently saved the file.

Clear filter criteria.

Sort filter criteria in ascending or descending order.

EXPLORE THE USER INTERFACE

TXLF Editor View
The TXLF Editor view is your default translation and review workspace.

You can choose from two layout views for your TXLF Editor workspace.

• Table view — This layout view displays the source segment to the left and the target segment to the right.

• Stacked view — This layout view displays the source segment row directly above the target segment in a
spanned row.

You can select either layout view by clicking the drop-down list for the Switch Editor Layout action on the File
tab.

 
Right-click anywhere in the source or target segments to access the TXLF Editor Context Menu.
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Item Action

WFP Menu Access different views, quick tools, and user preferences.

File Name Tab View an open or chained file.

Filter Bar Access all action buttons associated with a specific tab.

Menu Tab Access a specific function and its action buttons.

Action Bar Access all action buttons associated with a specific tab.

Action Button Perform a task.

Table Filter Create filter criteria and or search in the open file.
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Item Action

Collapsed Items Access any remaining tools that do not fit in the window.

Preview Pane View the translated content in its original format for MS Word .DOC
and .DOCX files or MS PowerPoint .PPT and .PPTX files.

Editor Pane Access editor tab content or interact with it using menus and sub-menus.

Source Segment Column View numbered color-coded segments after source file analysis.

Target Segment Column Use as primary work area for translation entry with or without leveraging a
translation memory (TM).

Terminology Pane Search the source or target glossaries, or add terms to terminology
glossaries, if enabled.

Segment Score Column View the TM match score represented as a percentage.

Status Column View the status of a segment.

Verification Column Verify and commit a segment with the .

TXLF EDITOR VIEW

Filter Criteria
Use filter criteria to constrain searches of segment content.

Option Function

Source or Target Select from drop-down menu to search source or target segments.

Match Case Make your search case-sensitive.

Regex Select from drop-down menu to search on regular expression or wild card
characters.

Filter Select from drop-down menu to constrain search even further.

Activate the filter action.
Clear the cumulative filter action.
Reset the toolbar filter fields.

Sort Select from drop-down menu to order the remaining search list.

Configure the maximum word count for the segment filter.

TXLF EDITOR VIEW

Segment Status
You can quickly identify the status of a segment in the TXLF Editor view by its status icon.
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Status Icon Segment Status

A non-linguistic error has occurred in the segment during a Transcheck test.

The segment is locked, so you cannot edit it.

The segment is unconfirmed, so you cannot commit it to the translation memory.

The segment repeats more than once in the current file.

There is segment information available.

The segment has a note associated with it.

The source segment has been modified.

TXLF EDITOR VIEW

Progress Bar
The TXLF Editor registers translation progress at the lower right of the window.

Item Behavior

Segments View the number of segments completed versus the total number of segments.

Segment (Src/Tgt/Max) View the number of characters in a source segment and the target segment,
followed by the maximum number of characters allowed in the target segment.

Note: The Max segment value turns red when it exceeds the maximum allowed.

Paragraph (Src/Tgt/Max) View the number of characters in the source paragraph and the target paragraph,
followed by the maximum number of characters allowed in the target paragraph.

Note: The Max segment value turns red when it exceeds the maximum allowed.

Word Count Progress Bar View the percentage complete and the number of words remaining.

Best Practice: The percentage complete will not progress if the target segment
is empty, or if you have not modified machine translated or fuzzy segments.
To progress to the next unedited or machine translation (MT) fuzzy segment,

either use the Verify Segment action on the Translation tab or use the  in the
Verification column. Use the Recalculate Progress action button on the File tab
to update the progress bar for files created or edited in legacy versions.

Note: For Japanese, the percentage complete is in characters, not in words.

EXPLORE THE USER INTERFACE

Quick Tools View
Use the Quick Tools view to work with files outside of your projects. Typically, Project Managers use Quick
Tools actions to perform regular functions on files before sending them to linguists, such as analysis or cleanup.
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Item Action

WFP Menu Access user views and user preferences.

Source Files Pane Select from the available source files list.

TM Pane Select and create TXLF files of the translation memory or configure reports.

Action Button Perform a specific task.

Action Bar Access all action buttons associated with a specific tab.
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EXPLORE THE USER INTERFACE

Help and Feedback

HELP AND FEEDBACK

Help
Access online help by selecting the Help action button on the Help tab. If you still have questions after reviewing
online help information, email Hotline Support at support@translations.com.

 
Do not submit requests for changes to the software using Help.

 

HELP AND FEEDBACK

Feedback
For software issues only, click Feedback. Be as specific as possible, providing the exact steps you took when the
issue occurred.

 
Do not submit questions related to software usage to Feedback.
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4. Manage Projects
When Wordfast Pro opens, the default view is the Project List view. Once you create a project, you can keep a
project on the project list for as long as it takes to complete it. A project stays in the project list until you remove it.

  You can add a project to the Projects List again, even after you removed it. Wordfast does not erase
removed projects, so you can still retrieve them from the project folder on your computer using the
Add Project action.

The Project List view is where you use file format filters; add files; set source and target languages; and select
translation memories (TMs), terminologies, and reference files to manage the translation process for the project.

 
To bypass the typical project creation process, create a Quick Project with the Open TXLF action.

Open a TXLF File
In Wordfast Pro, every translation begins with a project. You may bypass the typical project creation steps
and create a Quick Project by either choosing to drag-and-drop TXLF files into the project list or use the Open
TXLF action. You can access all features and actions available for a standard project with the following two
requirements: you must use TXLF files and you cannot use the Import Package action.
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  You can drag-and-drop TXLF files to a project as long as they have the same source language. You
must open a new Quick Project for each new source language.

  You must save the Quick Project to retain it in the Project list. If you do not save the project, all
changes you made to the original files in the submission are preserved.

To open a TXLF file:

 1. Choose one of the following actions:

• On the Projects tab, click Open TXLF, then browse to select a file.

• Drag-and-drop one or more TXLF files to the project list.

 2. If you used drag-and-drop, determine if you want to remember your choice on the Quick Open TXLF dialog,
then choose one of three possible actions.

a) (Optional) Select Remember this choice to use your selected option each time you choose the Quick
Open TXLF action without displaying the dialog again. Use General Preferences > General to show this
dialog again, after you choose to Remember this choice.

b) Click Open in a New Project to use the standard Project Creation dialog.

c) Click Open in Quick Project to open the TXLF file or files in TXLF Editor as a temporary Quick Project.

d) Click Cancel to disregard the TXLF files and close the dialog.

 3. If you chose to open the Quick Project, make your edits in the TXLF Editor.

 4. (Optional) Click either Save or a Save Options action.

 5. (Optional) In the Current Project view, click Save Project to retain the project in the project list.

 6. In the Save Project dialog, modify the project details.
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Required fields are marked with a red asterisk.

a) Enter the Project Name.

b) Browse and select the file location in the Save Project To field.

c) Click Save.

Create a Project
In Wordfast Pro, every translation begins with a project. Projects act as repositories for all related content, along
with associated translation memories (TMs) and glossaries.

 
You must create a project before you begin translation, unless you use the Open TXLF action.

  A project also requires file format filters to convert the source content into segments prior to beginning
the translation process.

To create a project:

 1. On the Projects tab, click Create Project.

 2. On the Project Creation dialog, enter a project name.

Required fields are marked with a red asterisk.
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 3. (Optional) If you want to reuse the profile of a previously created local project, select it from the Reuse Project
drop-down list.

 Project reuse removes all existing translation memories, glossaries, and blacklists from the new
project. On the Reuse Project Warning dialog, click Yes to agree to reuse the project.

 4. Enter the Save Project To location or click Browse... to select the location for your project.

 5. Select Source Language and Target Language(s) from the drop-down lists.

 You can refine the source language and target language drop-down list results by starting to type a
language name.

 6. In the Editor pane, click the Translation Memory tab, if it is not already active.
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 7. (Optional) Click Create to add a new local TM for your project.

a) On the Create TM dialog, enter a unique name for the TM.

b) Select a target language to create a language pair, then select the location for the TM on your local disk.

c) Select either primary or secondary priority from the drop-down list to determine the TM you leverage first.

 You can select only one TM as the primary. The primary status dictates that the content of that TM
overrides any content in secondary TMs.

d) (Optional) To prevent any edits to the TM, select Read-only.

e) Click OK.

 8. (Optional) To add an existing TM to your project, click Add, then select a local, remote, or a project-specific
TM from the drop-down menu.

 To use a free online tool for work and production that integrates with Wordfast Pro, use Wordfast
Anywhere (WFA) as your remote, unlimited, and private TM.

a) Local — Select a location on your local disk.

b) Add Remote — Enter the TM Server or WF Server or WFA Server details on the Connect to Remote TM
dialog. Refer to Connect to a Remote TM.

c) Add Project TMs — Enter the details on the Add Project TMs dialog by selecting the project.

 The source language, target languages, and list of TMs auto-populate, based on the project you
select. Remove the target languages or TMs that you do not want to import from the target languages
and list of TM fields.

 9. (Optional) To import an existing TM to your project, click Import.

a) On the Import Translation Memory dialog, select the import File Type: TMX or WF TXT TM format from
the File Type drop-down list.

b) Click Browse to locate and select the project file that contains the TM that you want to import.

c) Select either the Create a new TM or Import into existing TM option. Refer to Import a Local TM.

d) If the TU already exists, select an overwrite option from the drop-down list.

e) Select Clear before import if you want to ensure the import overwrites a clean TM.

f) Click OK.

 10. (Optional) To edit an existing TM in your project, click Modify.

a) On the Modify Local Translation Memory dialog, modify the name of the TM or its priority.

b) Select whether you want to protect the TM as read-only.

 11. (Optional) In the Editor pane, click the Glossary tab.
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 12. (Optional) Click Create to add a new local glossary for your project.

a) On the Create Glossary dialog, enter a unique name for the glossary.

b) Select a target language from the drop-down list, then select the location for the glossary on your local disk.

c) Select either primary or secondary priority from the drop-down list to determine the glossary you leverage
first.

 You can select only one TM as the primary. The primary status dictates that the content of that
glossary overrides any content in secondary glossaries.

d) If you want to prevent any edits to the glossary, select Read-only.

e) Click OK.

 13. (Optional) To add an existing glossary to your project, click Add, then select a local, remote, or a project-
specific glossary from the drop-down list.

a) Local — Select a location on your local disk.

b) Add Remote — Enter the TMGR Server or WF Server or WFA Server details on the Connect to Remote
Glossary dialog. Refer to Connect To a Remote Glossary.

c) Add Project Glossary — Enter the details on the Add Project Glossary dialog by selecting the project.

 14. (Optional) To import an existing glossary to your project, click Import.

a) On the Import Glossary dialog, select the import File Type: TBX or Tab delimited.

b) Click Browse to locate and select the project file that contains the glossaries that you want to import.

c) To configure a glossary creation option, select either the Create a new glossary or Import into existing
glossary. Refer to Import a Local Glossary.

d) Select an overwrite option for preexisting terms.

e) Select Clear before import if you want to ensure the import overwrites a clean glossary.

f) Click OK.

 15. (Optional) In the Editor pane, click the Blacklist tab.

 16. (Optional) Click Create to create a new local blacklist for your project.

a) On the Create Blacklist dialog, enter a unique name for the blacklist.

b) Select a target language for the blacklist, then select the location for the blacklist on your local disk.

c) If you want to prevent any edits to the blacklist, select Read-only.

d) Click OK.
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 17. (Optional) To add an existing blacklist to your project, click Add, then select a local or remote blacklist from the
drop-down list.

a) Local — Select a location on your local disk.

b) Add Remote — Enter the details on the Connect to Remote Blacklist dialog. Refer to Connect to a
Remote Blacklist.

 18. (Optional) To import an existing blacklist to your project, click Import.

a) On the Import Blacklist dialog, select the import File Type: TXT.

b) Click Browse to locate and select the project file that contains the blacklist that you want to import.

c) Select the blacklist creation option: Create a new blacklist or Import into existing blacklist. Refer to
Import a Local Blacklist

d) Select an overwrite option for preexisting terms.

e) Select Clear before import if you want to ensure the import overwrites a clean blacklist.

f) Click OK.

 19. On the Source Files tab, choose a method to add project source files.

 
You can drag-and-drop files from a folder to the Files panel.

 To copy source files into the Source File folder within the Project folder on your computer, select
Copy Source Files into Source Folder in your General Preferences.

a) (Optional) Add File — Click to browse to the source file.

b) (Optional) Add Folder — Click to browse to the folder location for source files.

 20. (Optional) On the Reference Files tab, choose a method to add supporting documentation.

a) (Optional) Add File — Click to browse to the source file.

b) (Optional) Add Folder — Click to browse to the folder location for source files.

 21. (Optional) Select any additional Options.

Run analysis report on
documents

Analyzes source files against TMs and generates a report. You can also view this
report on the Reports tab, after opening the project.

Pre-translate TXLF files Populates TM leveraged segments when TXLF files are open.
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Use primary MT on no
match segments

Leverages primary machine translation (MT) when there are no matches with the
local and remote TMs. This option is only available if you selected Pre-translate
TXLF files.

 22. Click Create Project to analyze the files and display the project creation summary.

 23. (Optional) On the WordFast1 dialog, select Open created project.

 24. Click OK.

The project is created.

Open a Project
Once you create a project, the next step is to open it. You cannot open files for translation without first opening
the associated project.

To open a project on the Projects tab:

 1. Select a project name from the project list on the Projects tab.

 2. Click Open Project or double-click the project name to open it.
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The files ready for translation are displayed below the folder for the project language pair on the Project Files
tab.

Modify a Project
You can change the project name and target language using the Modify Project action.

To modify a project:

 1. On the Projects tab, select a project, then click Modify Project.

 2. (Optional) On the Modify Project dialog, enter a different title in the Project Name field. 
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 3. (Optional) Add a language in the Target Language(s) field by selecting one from the drop-down list or remove
a language by deselecting it.

 4. Click OK.

The modifications are active and the project list displays.

Remove a Project
To remove a project:

  You can add a project to the Project List again, even after you removed it. Wordfast does not erase
removed projects, so you can still retrieve them from the project folder on your computer using the
Add Project action.

 1. On the Projects tab, select the project to remove, then click Remove Project.

 2. On the Remove dialog, click one of the action buttons.
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Remove from the list only Remove the project from the Projects List but retain
project resources in the project folder on your computer.

Remove from the list and move the following
resources to Archive folder

Move the project TXLF, reference, and source files to
the Archive sub-folder within the project folder on your
computer.

 3. Click OK.

The project is no longer in the Projects List.

Package Files
A package file contains all of the required information to work on a translation project. You can use a package file
to share content and files among different Wordfast Pro (WFP) users. The package file can contain complete or
incomplete projects.

A package file generally includes:

• Source files

• All target translatable files

• Instructions

• Background information

• Reference files

• Comments

• Connection to at least one Translation Memory (TM)

• Connection to at least one glossary and blacklist

To access a package file from another user, import the file into WFP. Wordfast connects the imported files to
translation memories and glossaries. It provides you access to all translatable files and additional resources,
including TMs and glossaries, without any additional setup or configuration.

To share a completed project with other users, export it as a package file.
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PACKAGE FILES

Import Package Files
Package files allow different Wordfast Pro (WFP) users to share files. When you import a package file, you
automatically connect the files to translation memories and glossaries. You also gain access to all translatable
files and additional resources. This eliminates the need for manually creating a project.

To import package files:

 1. On the Projects tab, click Import Package.

 For ease of use, you can drag-and-drop a package file and move it into the application window white
space.

 2. On the Import Package dialog, click Browse to locate and select the package file.

Required fields are marked with a red asterisk.
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 3. Choose one of the following:

• Update a project by clicking Update an existing project and its options.

• Create a new project by clicking Create a new project and its options.

 4. (Optional) Select Open project after importing to open the updated or new project when the import
completes.

 5. Click Import.

The package file is imported.

 If you did not deselect Open project after importing, the current project view opens and displays
files for translation.

PACKAGE FILES

Export Package Files
Use Export Package to share a complete project package with other Wordfast Pro (WFP) users.

To export package files:

 1. Select a project on the Projects tab, then click Export Package.

 2. On the Export Package dialog, select either Entire Project or Specific target languages and resources.
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Entire Project Click to export all target languages and their associated resources.

Specific target
languages and
resources

1. Click to export specific target languages and associated resources.
2. Click items from the drop-down list for further options to deselect specific

Target Language and resources for exclusion from the export.

 3. Choose an existing name from the Select Naming Convention drop-down list or enter a name of your choice
in the Custom Name field.

 
The Preview field provides the name of the file as it will export below the Package Name fields.

 4. Select a save location for the project package, then click Export.

The exported project package is built and saved to the folder location.
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PACKAGE FILES

Import SDL Package Files
You can import an SDL package file for conversion of SDL source files to a compatible Wordfast Pro format.
Imports include scores for source content, but do not include translation memories, glossaries, and reference files.

To import SDL package files:

 1.  On the Projects tab, click Import SDL Package or drag-and-drop the SDL Package file into the application
window.

 2. On the Import Package dialog, click Browse to locate and select the SDL Package file.

 If the SDL Package file contains unsupported target languages, a warning message notifies you.
Click OK.

 3. Enter the new Project Name.

 4. Browse and select the save location for the new project.

 5. (Optional) Select Open project after importing to open the project automatically after import.

 6. Click Import.
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The SDL Package file import completes. For imports with Open project after importing selected, the current
project view is opened and the files for translation are displayed.
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5. Manage Project Files
When you open Wordfast Pro, the default Project List view lists all projects you can open. When you open
Wordfast Pro for a project with multiple files, the Current Project view lists all files associated with the project
below the language pair on the Project Files tab.

Add Files
You can add files to an existing project using the Add Files option on the Project Files tab.

  • If one or more of the source files has a different language code, you will receive a prompt to
modify the project and add the new target language.

• You can add files to a project with different language code variants, as long as they are not
country specific. For example, a project with the country code EN > DE accepts files of any
language code variants. However, if the project language code is EN-US > DE-DE, the only
acceptable additional language code is the generic EN > DE.

To add files to a project, on the Project Files tab:

 1. Click Add Files.

 2. Browse to and select one or more source files on the Open dialog.

 3. Click Open.

 4. On the Files Report dialog, click OK.
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Add a Folder
You can add a folder containing multiple files to an existing project using the Add Folders option on the Project
Files tab.

To add a folder to a project:

 1. On the Project Files tab, click Add Folders.

 2. Click Select Folder.

 3. On the Files Report dialog, click OK.

Open a Source File
You can view a source file in its original format.

To open a source file:

 1. Click Open Source File  on the Project Files tab.

 2. View the source file when its default application opens.

 
If the default application is not set, choose an application when prompted to do so.

Close a Project
When you are finished working on a project, close it before you open another.
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You can only have one project open at a time.

 1. Click Close Project on the Project Files tab.

 2. (Optional) On the Projects List view, select a new project from the list and click Open Project.

Conduct a Bilingual Export
Use Bilingual Export to export the TXLF file with highlighted glossary terms into a .DOC or .DOCX format. This
allows you to edit and spell check the file using Microsoft Word, rather than the internal spell check. You can also
complete a bilingual export or import outside the Project List view using Quick Tools.

  Bilingual exports require you to set Bilingual Export Options in Preferences > General
Preferences.

To conduct a bilingual export:

 1. On the Project Files tab, select a file or multiple files, then click Bilingual Export.

 
You cannot select files that are already open for bilingual export in TXLF Editor.

 2. Select the destination folder for the exported documents, then click Select Folder.

The session log is displayed. This log and the exported Word documents are saved in the selected folder.

 3. (Optional) Open the bilingual export report and review the results.
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Analyze Project Files
Project analysis compares source files to a connected translation memory (TM) to leverage reusable content. Use
the Analyze action to assess files prior to translation or to pre-translate files.

To analyze project files:

 1. In the Current Project view, click Analyze.

 2. On the Project Analyze dialog, select the language pairs and files for analysis.

 Verify that the TXLF file you want to analyze is not open in TXLF Editor. You cannot analyze an open
file.
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 3. Select options below the Analysis Options heading.

Option Action

Pretranslate Select to create translated TXLF files, based on Pretranslate options.

Note: Selecting Pretranslate is an optional step. The percentage defines the
minimum leverage required to pre-translate a specific segment.

• % matches—Select the percentage of matches to pre-translate

• Copy all tags on segments when there is no TM match

• Copy segment source to target when there is no TM match

• Do nothing

Calculate analysis
report percentage by:

Click an option to set the calculation percentage by either words or segments.

Calculate internal fuzzy
matches

Select to set the calculation percentage for internal partial matches.

Lock segments with
100% matches from
being edited

Click to prevent the edit of 100% matches and the overwrite of the TM with those
edits.
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Option Action

Do not allow segments
to be merged

Click to prevent the merging of translation units (TUs) during analysis.

Do not allow sources to
be edited

Click to prevent an overwrite of the source segment with new edits.

 4. Select the format for the output report below the Report Settings heading.

a) (Optional) Click Show only analysis report summary.

b) (Optional) Click Export Report, then complete the required fields and select a location.

 5. Select a TM below the Translation Memory heading.

 6. Click Analyze.

 7. On the Report File dialog, view the project files analysis.

 8. Click OK.

Run a Transcheck Report
Use Transcheck Report to verify target segments and flag a variety of common errors within segments. Run a
Transcheck Report on one or more languages or files in a project.

  If you have specific terms you want Transcheck to ignore, you can mark those segments for exclusion
in the Transcheck Report using the Transcheck All action. This reduces false positives during
Transcheck error detection. Refer to Use Transcheck All.

To run a Transcheck Report:

 1. Click Transcheck Report on the Project Files tab.

 2. On the Project Transcheck dialog, select one or more languages or files.
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 3. Select the Transcheck Tests you want to conduct.

 Consistency checks are only accessible through the Project Transcheck dialog.

1. Source consistency check — Use to search for segments with the same target translation,
but with different source segments.

2. Target consistency check — Use to search for segments with same source segments, but
with different target translations.

Select the appropriate checkbox to ignore differences such as case, numbers, tags, and whitespace
for source and target file consistency checks.

 4. Enter the Report Name and browse to select the Report Location folder.

 5. (Optional) If you want to enable the Terminology Check or Blacklist Check tests, select the location of the
Glossary or Blacklist you want Transcheck to use from the list on its tab.

 6. Click Run Transcheck.
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A Report Summary is created, and the report is saved to the chosen location.

Generate a Segment Changes Report
A segment changes report provides you with the history of changes to a segment. You can run a Segment
Changes Report on one or more project files.

To generate a segment changes report:

 1. Select a single project file or multiple project files on the Project Files tab, then click Segment Changes
Report.

 2.  On the Segment Changes Report dialog, select the languages or files to include in the report.
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 3. Select options from the Report Settings pane.

Option Action

Show/Hide Columns Note: Comments, ratings, and notes each have their own column. Blank columns
indicate the feature you selected is not available or there is no data related to that
option for the segment.
Select the columns you want displayed by clicking the appropriate check boxes.

• Notes, comments, and ratings — Translators and reviewers each have
their own notes column. Only reviewers can add comments and ratings.

• Post Edit Distance — Compares new target content to prior target content
and determines how different they are, down to character additions and
deletions.

Enable Diff Highlight Select to compare differences between new target content to prior target content.
Red strike-through highlights indicate deletions and green highlights indicate new
content.

Show all segments Select to download all segments in the Segment Changes Report, regardless of
any change to the target segment.

Show latest revision
from a phase

Select to include the latest content from a specific workflow phase, regardless of
total number of revisions for that phase.

Open report after export Automatically open the report once the export completes.
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Option Action

Filter Phase-name(s) Filter content in the report by a specific workflow phase by selecting that phase
from the drop-down list, then choose to include all phases prior to the selected
phase name.

Filter Process-name(s) Filter content in the report by a specific process, such as No Review or Review
from the drop-down list, then choose to include all phases prior to the selected
phase name. This can be inclusive, so you can select several processes.

Custom Report Name (Optional) Enter a unique name for the report if it requires customization.

Report Location Browse and select the file location for saving the segment changes report.

 4. Click Export.

 5. On the Segment Changes Summary dialog, verify the names of the files you chose to include, then click OK.

 6. Open the Segment Changes Report in a new browser window, then close the browser window when you are
done.

Generate an Export Notes Report
The notes report is an HTML file that includes all notes added to the bilingual project files.
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To generate an Export Notes Report:

 1. On the Project Files tab, click Export Notes Report.

 2. On the Export Notes Report dialog, select one or more project language files.

 3. Browse and select the Report Location destination, then click Export.

 4. On the Export Notes Summary dialog, click OK.

The notes report saves to the specified location.

Clean Up a Project
After you have translated project files, it is time to clean them and update the translation memory (TM). The Clean
Up action converts the bilingual TXLF files into translated target files with the file format of the source.
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To clean up the project and update the TM:

 1. In Current Project view and on the Project Files tab, click Clean Up.

 2. On the Project Clean Up dialog, select a language or languages.

All Language Pairs Click to clean up all language pairs for the project

Specific Language Pairs Click to clean up only the language pairs you specify from the drop-down list

Single Language Pair Click to clean up only one language pair you select from the drop-down list

 3. Specify the location for the translated files from the drop-down list.

 4. (Optional) Select Create subfolders by language.

 5. (Optional) Select Add language suffix to the translated file name.

 6. Select TM Overwrite Options from the drop-down list.

 7. Select the TM(s) to Update from the table.

 8. Click Clean Up.

 9. On the Info dialog, click OK.
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The cleaned files are saved at the designated location.

Remove a File
If you decide a file does not belong with a specific project, remove it.

  You can add a removed file back to the current project. Retrieve removed files from the project folder
on your computer by using the Add Files action.

To remove a file from a project:

 1. On the Project Files tab, select one or more files, then click Remove File(s).

 2. On the Remove dialog, choose a removal option.

Remove from the list only Click to remove the file from the files list

Remove from the list and move the
following resources to Archive folder

Click to remove the file from the list and move file resources to
your local Archive sub-folder

 3. Click OK.

The files are removed from the current project.
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6. Translate or Review Files
After completing the initial steps of creating a project, connecting to translation memories, and glossaries, the
project files are ready for translation in the TXLF Editor view. After completion of the translation, the project files
are ready for review, using the same TXLF Editor.

Translate a File
 

Save your work often by clicking Save on the File tab or by pressing Ctrl+S.

To translate a file:

 1. On the Project Files tab, select a file, then click Translate File.

 2. (Optional) On the Translation tab, copy all tags in the source segment to the target segment. Refer to Copy All
Tags.

 3. Select a target segment and enter the translation.

 4. Click Next Segment or press Alt+Down to update the TM, move down one target segment, and leverage the
content of the next segment.

Translate Segments
When you convert a file to a translatable TXLF format, all complete sentences become separate segments,
often divided by formatting or punctuation. Segments may be sentences, words, or numbers, depending on
the formatting of the source file. After you save the segment translations, the application commits the segment
translations to the translation memory (TM). Leveraging the TM automatically and consistently reduces the time
and expense of future translations by translating reoccurring words and phrases.
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  To facilitate rapid use of language-specific quotation marks, punctuation, and white space, select
Enable Smart Quotes in Preferences > General Preferences > Segment.

You can choose from two layout views for your TXLF Editor workspace.

• Table view — This layout view displays the source segment to the left and the target segment to the right.

• Stacked view — This layout view displays the source segment row directly above the target segment in a
spanned row.

You can select either layout view by clicking the drop-down list for the Switch Editor Layout action on the File
tab.

  If there are either split or merged segments, indicated in the Status column with  or , all split or
merged rows within the spanned row have the same ID column color.

TRANSLATE SEGMENTS

Translate All Segments
The Translate All option completes the translation of all segments by leveraging content in the connected TMs.

To translate a project file using Translate All:

 1. In TXLF Editor, click inside a segment.

 2. Click Translate All.
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This leverages content in the connected TM and populates the target segments with translations. When this
process is complete, the screen refreshes and displays the results in the target column. The progress bar
indicates the percentage of translation already complete.

TRANSLATE SEGMENTS

View Segment History
In TXLF Editor, view the record of segment changes to the open file on the Segment History tab of the Editor
pane. Changes to segments include segment updates, as well as verify and lock actions.

TRANSLATE SEGMENTS

Verify a Segment
Use the Verify Segment action to automatically modify and commit to a translation memory (TM) a 100%, fuzzy,
context match, or machine translation (MT) match segment, if the segment does not require any further changes.

  When you verify a segment, it automatically calculates the segment content into the total progress for
the file. Progress totals display in the progress bar using a completion percentage.

To verify a segment:

 1. In TXLF Editor, select a segment.

 2. Either click  or click Verify Segment on the Translation tab.
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The segment status is changed to Edited and the segment is committed to the TM, changing the highlight
color of the target segment to purple. When you move to the next segment, the target highlight changes from
purple to pink.

TRANSLATE SEGMENTS

Copy Source Content
To copy source content to the target:

 1. In TXLF Editor and on the Translation tab, select a source segment.

 2. To copy the source content, choose one of the following:

• Click Copy Source.

• As a shortcut, press Alt+S to copy the source content.

 3. Select a copy action from the resulting drop-down menu.
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Option Action

Copy Source Select to copy from source all content and tags to the target.

Copy Source Text Select to copy only content from source to the target.

Copy Source, Tags and Term
Translations

Select to copy from source to target all content text, its tags, and
translated concordance glossary terms.

Copy Source and Term
Translations

Select to copy from source to target all content text and translated
concordance glossary terms.

Copy Source, Tags, Source and
Target Terms

Select to copy from source to target all content text, its tags, and both
source and translated concordance glossary terms.

Copy Source with Source and
Target Terms

Select to copy all source and translated concordance glossary terms to
the target.

The specified source content is copied to the selected target.

TRANSLATE SEGMENTS

Copy All Source Segments
To copy all source segments to all target segments:

 1. In TXLF Editor and on the Translation tab, click Copy All Sources.

All source segments are copied to all segments in the target column.

 2. (Optional) Begin translation in the target column.

TRANSLATE SEGMENTS

Split or Merge a Segment
You can split or merge an existing segment to change segmentation. This is particularly useful for certain file
types or for languages where the next segment content may need to precede the previous segment. The best
time to split or merge a segment is early in the translation process.

To split or merge a segment:

 1. In TXLF Editor, on the Translation tab, select the segment to split or merge.

 2. Click Merge or Split.
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The segment is merged or split and the segment Status column contains either  or , respectively. If the

merge includes an entire paragraph, this is denoted with .

TRANSLATE SEGMENTS

Lock a Segment
You can lock a segment to prevent any further changes to that segment. The best time to lock a segment is when
the translation is complete and the reviewer has confirmed the content after proofreading it. The Commit action
still updates the translation memory (TM) with the target segment content.

To lock a segment:

 1. In TXLF Editor and on the Translation tab, select the segment to lock.

 2. Click Lock Segment.

The  is displayed in the segment Status column to indicate the segment is locked.
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TRANSLATE SEGMENTS

Clear Target Segments
To clear target segments:

 1. In TXLF Editor and on the Translation tab, select a target segment.

 2. Click Clear Target.

 3. From the drop-down menu, choose one of the following:

• Select Clear Target to clear the selected target segment.

• Select Clear All Targets to clear them all.

 4. On the Clear Current Segment Target dialog, click Yes to agree to the target content removal.

The target content is removed.

TRANSLATE SEGMENTS

Unconfirm a Segment
Translators can temporarily mark a segment that should not be committed to the translation memory (TM) using
the Unconfirm/Confirm action. This allows translators to temporarily mark the segment, later refer to translation
resources, make any changes, then confirm the translation for that segment based on that research.

To unconfirm a segment:

 
You can only unconfirm a segment that is already confirmed.

 1. On the Translation tab, choose one of the following actions:

• Press Alt+Shift+Enter for unconfirm all segments.

• Click Unconfirm/Confirm.

The TM is not updated with the target segment content.

The  is displayed in the segment Status column.
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 2. (Optional) To later confirm the segment, click Unconfirm/Confirm again.

TRANSLATE SEGMENTS

Edit a Source Segment
You can modify the source content of a TXLF file, since you can restore the original source content at any time.
To update the translation memory (TM), commit the edited source segments.

To edit a source segment:

 1. In TXLF Editor, select a source segment.

 2. On the Edit tab, click Edit Source.

 3. Edit the source content, then click outside the segment.

The source segment is saved and the  is displayed in the Status column.

 4. To return to the original source, click Revert Source.

Review a File
To review a file:

 1. In the  Project List view, double-click a project.

 
Projects with a single file automatically open in TXLF Editor view.

 2. In TXLF Editor, review the source segment and the translation, then make changes to the Target segment as
needed.

 Verify that all tags in the Source segment are in the corresponding location within the Target
segment.
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 3. (Optional) Click Find/Replace to search for and replace repeated content. Refer to Find and Replace Content.

 4. Click Next Segment or press Alt+Down to update the TM, move down one segment, and leverage the next
segment from the TM.

 
Save your work often by pressing Ctrl+S or clicking Save on the File tab.

Chain Files
To combine multiple files and view them as a single file, use Chain Files. For example, if you are translating or
reviewing ten files with ten segments each, you can temporarily chain them into a single file of 100 segments.
This is particularly useful when working with duplicate or similar content among files.

 
You cannot export or save chained files as a single TXLF file.

  You can open and work on a single chained file or multiple sets of chained files in the TXLF Editor
view. Each chained file displays on its own tab.
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To chain files:

 1. On the Project Files tab, select a set of files, then click Chain Files.

 
Use Shift+Click to select sequential files or Ctrl+Click to select individual files.

The chained file opens in TXLF Editor with a default filename of Chained Files 1. Each file in the chain
starts with segment ID 1 and ends with a file divider.

 
To determine the related file name for a segment, hover over the segment ID.

 2. Click a segment to make it the active segment.
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The filename changes from the chained name to the source filename of the active segment.

 3. Translate, review, or edit each segment.

 4. Click Save on the File tab to save the chained file.

The segments are saved in the chained file and restored to their original files without the chained format.

Find and Replace Content
Use Find/Replace to search for and replace text in translated content.

To find and replace content in a file:

 1. In TXLF Editor, click the Edit tab.

 2. Click Find/Replace.
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 3. On the Find/Replace dialog, click in the Find what field, then enter your search text or select it from the drop-
down list.

 4. (Optional) Click  and  to expand and collapse the panel for additional options.

 
Search text can include regular expressions (Regex), wild card characters, and non-breaking spaces.

 5. Click Find Next to move through all instances of the content.

 6. (Optional) Click Reading Highlight and select the Highlight All action from the drop-down list to highlight all
instances of the content in all open files.

 7. (Optional) To replace regular expressions, wild card characters, or words, click the down arrow on the sidebar,
then click .

 8. Click in the Replace with field and enter a replacement.
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 9. (Optional) Select the direction of the search and any further options.

 You cannot use the Whole Words Only search option when entering multiple words or punctuation in
either search field.

 
Select Use Regex to search on regular expressions or wild card characters.

 10. (Optional) Click one of the following actions : Replace, Replace All, Find Next, or Close.

The content you found has been replaced with the new content.

Spell Check a File
You can use a spellchecker to verify translated content aligns with configured spell checking preferences. Refer to
Configure and Enable Spellchecker. You must verify your Hunspell spelling dictionaries have the latest updates.
Refer to Licensure.

To spell check a file:

 1. On the Review tab, click Spellcheck File.

 2. On the Spelling dialog, review the suggestions and select one of the options.
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Item Action

Ignore Once Click to ignore the suggested change for a word only once.

Ignore All Click to ignore the suggested change for all occurrences of a word in the file.

Change Click to accept the suggested change for a word.

Change All Click to accept the suggested change for all occurrences of a word in the file.

 
If spell checking is not available for the target language, a warning message notifies you. Click OK.

 3. To view spell checking preferences, click Preferences or click Cancel to reject any changes.

 4. Close the Spelling dialog.

Leverage Translation Memory
Translation memory (TM) acts as a database to provide maximum re-use of previously translated content. It also
serves to facilitate collaboration between globally distributed localization resources.

Projects connected to a translation memory (TM) leverage content matches against an existing TM. TM matches
generally fall into three categories: 100% match, fuzzy repetitions, or no match. Your organization may choose to
alter or add more fuzzy repetition categories. The typical fuzzy repetition values are for 95% to 75% matches. The
segment highlight identifies the type of TM match.

Color Code Category

Green Indicates a 100% match.
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Color Code Category

Green, Dark Indicates a context match. A context match for a segment must meet one of the
following criteria:

• The segment has a correct checksum or attribute match.

• The previous and next segments also have a 100% match.

• The 100% matched segment is a single paragraph.

Grey Indicates there is no TM match.

Pink Indicates a modified segment.

Pink, Light Indicates the segment was a machine translation (MT) instead of a human translation.

Purple Indicates an update to the TM for a modified segment.

Purple, Light Indicates the update to the TM of a translated and committed segment automatically
updates other repetitive segments within the translation.

Yellow Indicates a fuzzy match.

LEVERAGE TRANSLATION MEMORY

Leverage a TM
Leveraging a segment involves selecting the best possible translation from the connected translation memories
(TMs) or machine translation engines to populate target segments.

To leverage a TM:

 1. Follow the steps in Translate a File.

 2. Click the Translation tab in the TXLF Editor, then select the segments to leverage against the current TM.

 3. Select an action to leverage the current TM.

Leverage Select to leverage a single segment.

Until Fuzzy Select to leverage segment content until reaching a fuzzy match.

Until No Match Select to leverage segment content until there is no match.

Translate All Select to leverage all content in all segments.

LEVERAGE TRANSLATION MEMORY

Conduct a Concordance Search
A concordance search looks for specific source segment text in a translation memory (TM). To view concordance
search results for both source and target segments, use the TM Lookup tab in the Editor pane.

To conduct a concordance search:

 1. Click the Translation tab, then select a word or phrase in the segment in TXLF Editor.

 2. Click Concordance Search from the Translation Memory group or press F8.
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 You can also search for a word or phrase by entering it in the TM Lookup field. Then, to conduct
a search of both source and target, press Enter. Instances of the search term are highlighted in
the Editor pane, along with its bilingual equivalents. To conduct a more specific search, click Find
Source or Find Target.

 You can reorder the columns of the TM Lookup results. That reorganization remains, even after you
exit the software.

 3. (Optional) To refine the search, select More Options and select a check box from the drop-down list.

Option Action

Case Sensitive Select to filter by upper and lower case.

Exact Select to filter for only those terms organized in the same sequential order.

Automatic Leverage Select to automatically update target content when moving to a new segment.

Diff Highlight Select to highlight the difference between the submitted segment and the TM
source segment.

Include Private TU (GLTMS) Select to include private segments or translation units (TUs) when searching
a remote TM.

The refined search results for the word or phrase you selected are listed on the TM Lookup tab of the Editor
pane. You can use the results of your search in the related target segments.
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LEVERAGE TRANSLATION MEMORY

View TM Leverage Results
Leveraging the translation memory (TM) occurs automatically as you move through the target segments. This
provides you with the best possible segment matches from the TM and is the only search that uses scoring to
select the best match.

To view TM leverage results:

 1. In TXLF Editor, click on a source or target segment.

This populates the columns on the TM Lookup tab of the Editor pane and provides a score, based on TM
leverage results.

 2. Review TM leverage results in each TM Lookup column for that segment.

Item Behavior

Source Displays source segments provided by the TM. Any difference between the submitted
segment and the TM source segment is highlighted.

Target Displays target segments already in the TM.

Score Displays a TM leverage score.

• Percent (%) — 100% and fuzzy matches

• Plus (+) — Context matches

• Asterisk (*) — Secondary TM match

• Red outline — TM has assessed a penalty to the segment
Refer to Leverage Translation Memory for more information on TM color codes.

TM Name Identifies the name of the leveraged TM. If you are leveraging multiple TMs, it lists the
TMs in order of priority: primary, then secondary TMs.

Creation Date Identifies the TM segment creation date.

Creation User Identifies the username of the segment creator.

Last Modified Identifies the date of the last segment modification.
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Item Behavior

Modification User Identifies the user who last modified the segment.

Custom Attribute Identifies any segment custom attribute name and its associated values

 Status Acts as a button to access score breakdown information, including penalties.

 3. (Optional) To constrain the columns within the pane, click on any column head, then deselect the names of the
columns you want to hide.

LEVERAGE TRANSLATION MEMORY

Leverage Machine Translations
The machine translation (MT) feature can automatically populate target segments whenever you open a file
or when there are no translation memory (TM) segment matches. Select a project for your MT and configure
Machine Translation options under Preferences > General Preferences.

To leverage MT:

 1. In TXLF Editor and on the Translation tab, click Machine Translation to submit the source segment for MT
and populate the target segment with the results.

 2. (Optional) Verify that the quality of the translation for the source segments aligns with your requirements.

The target segments are populated with the MT for the source segments.

 3. (Optional) If you are updating the current segment only, continue your work and repeat as often as necessary
until you are ready to save and commit all translated segments to the TM.
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LEVERAGE TRANSLATION MEMORY

Commit to the TM
Once you have finished translating some or all of the file segments, update the translation memory (TM) with your
translation. This requires committing some or all of the translated target segments to the TM.

To update the translation memory:

 1. In TXLF Editor and on the Translation tab, choose one of the following:

• First select the segment, then click Commit to commit a single segment to the TM.

• Click Commit All to commit all segments in the file to the TM.

 2. (Optional) Verify that the updates you committed to the TM have a purple highlight.

 3. (Optional) If you are updating the TM for the current segment only, continue your work and repeat as often as
necessary until you have committed all translated segments to the TM.

Leverage Terminology Lists
Terminology lists provide users with the ability to standardize term usage and to control the use of terms, variants
of terms, and parts of speech allowed for terms. A terminology list includes a glossary, a specialized list of source
terms, their definitions, and their preferred translations. It also includes alternate phrases for blacklisted terms.

To set up a terminology list, refer to Configure Terminology.

Segment selection highlights terms from the terminology list in the Terminology pane along with potential
translation options.

  There are two possible methods for moving among terms in the Terminology pane.

• Click Next Term or Previous Term.

• Press Ctrl+8 or Ctrl+9.
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The term highlight identifies the type of translation match between the source term and the terminology list.

 
Use Highlight All Terms to view highlights for term matches in the open file.

Color Code Category

Green Exact term match

Yellow Fuzzy term match

Red Missing exact term match

Purple Missing fuzzy term match

LEVERAGE TERMINOLOGY LISTS

Add a Term
You can add terms to both local and remote glossaries. You need read and write user permissions to add terms to
a remote glossary that is not read-only.

To add a term to a glossary:

 1. In the Terminology pane, select a word in the source segment and, optionally, the translation in the target
segment, then click .

 2. (Optional) On the Add Term dialog, enter content in the Description field.

Required fields are marked with a red asterisk.
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 3. Select the proper Glossary from the drop-down list.

 4. Click OK.

The new term is added to the glossary.

LEVERAGE TERMINOLOGY LISTS

Edit a Term

 
You can only edit terms in the local glossary.

To edit a term:

 1. In TXLF Editor, and on the Terminology pane, select a term.

 2. Click .

 3. On the Edit term dialog, make your edits.
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 4. Click Modify

The term is edited.

LEVERAGE TERMINOLOGY LISTS

Insert a Term
To insert a term into the current target segment:

 1. In TXLF Editor, click at the location for term insertion.

 2. Select the term to insert from the Terminology pane.

 3. On the upper left of the Terminology pane, click .

The term is inserted into the target segment.

LEVERAGE TERMINOLOGY LISTS

Search for a Term
To search for a term:

 1. In the Terminology pane, enter a term in the terminology filter field, such as the term project.

 2. Click .
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The search results from the connected glossaries are displayed.

LEVERAGE TERMINOLOGY LISTS

Copy a Term
To copy a term from the glossary into the current target:

 1. In TXLF Editor, click a segment that contains glossary terms.

 2. On the Terminology tab, click Previous Term or Next Term to select a source term.

 3. Click on the target location where you want to copy to the glossary term.

 4. Click Copy.

The glossary term is copied to the target segment.

LEVERAGE TERMINOLOGY LISTS

Copy a Synonym
To copy a synonym for a term:

 1. In TXLF Editor, select a source term in a segment that has a glossary term.
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This highlights and adds a border around the source and target terms. Synonyms display in a temporary pop-
up pane and in the Terminology pane.

 

 2. Click within the target segment at the location where you want to copy the term.

 3. Click Copy.

 An alternative is to click the preferred target term from the Terminology pane. This also copies the
term to the cursor location in the target segment.

The target synonym is copied to the target segment.

LEVERAGE TERMINOLOGY LISTS

Remove a Term

 
You can only remove terms from local glossaries, not read-only or remote glossaries.

To remove a term:

 1. In the TXLF Editor, go to the Terminology pane.

 2. Select a term, then click .

 Use the Delete Term  at the top of the Terminology pane. Do not use the Reset Search . This
clears the filter.
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A warning message notifies you of the pending deletion and asks you to agree to the term removal.

 3. Click Yes.

The term is removed from the local glossary.

Manage Tags
Tags contain information related to a block of text, such as format or indentation. Tags are not translated and
come in pairs: an opening and a closing tag.

 
Translations must retain the same tags at the correct location within a target segment.

  Unless you have disabled Remove incomplete tag pairs in Preferences > General Preferences >
Tags, a warning message results when you try to save a target segment with a missing tag or an
open tag. An open tag is part of a tag pair in the target segment that is missing its matching close tag.
The warning will give you three choices: Fix Manually, Delete, or Always delete.

Hover over a tag to view tool-tip information.

Tags contain numerals to indicate their order in the segment.

Red This is a tag you currently selected, such as the first tag, , in the file.

Purple This is a tag that specifies formatting, such as

Blue This is a tag that specifies non-formatting controls, such as .

MANAGE TAGS

Copy a Tag
Translated content retains the formatting of the source content, so tags are an important element in the final
translation. You can copy tags from the source to the target for formatting and indentation accuracy.

 
Use Preferences > General Preferences > Tags to configure tags as full-sized or shortened.

To copy a tag:

 1. Open a file.

 2.  In TXLF Editor and on the Translation tab, select a segment with tags.

 When the selected segment contains tags, the first tag is automatically selected. Red indicates
selection.
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 3. Choose one of the following actions:

• Click a source segment tag and drag it to the corresponding location in the target segment or press Ctrl-
Down.

• Click a source segment tag, then click in the corresponding target segment location and click Copy.

The target segment, highlighted in pink, contains the copied tag at the cursor location you selected in the
target segment.

 4. (Optional) Click Previous Tag or Next Tag to select another tag and repeat the process.

MANAGE TAGS

Copy All Tags

 
Use Preferences > General Preferences > Tags to configure tags as full-sized or shortened.

To copy all tags:

 1.  In TXLF Editor, open a file.

 2. On the Edit tab, click Copy All Tags.

 All copied tags display at the location of the cursor. Reorder them to mimic the source content order
using the drag-and-drop or copy-and-paste technique.

 3. Select Segment or Document from the drop-down menu.

Segment or Alt+A Select to copy only the tags for the selected segment to the target.

Document or Alt-Shift+P Select to copy all tags for the entire document.

All tags are copied to the segment or document.
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MANAGE TAGS

Edit a Tag
Most tags in your target content have specific formatting and indentation settings copied from the source. You can
modify tags to change content format in the translated file.

 
Do not edit tags in the source segment.

To edit a tag:

 1. Open a file.

 2.  In TXLF Editor, select a tag in a target segment.

 3. Choose one of the following actions:

• On the Translation tab, click Edit Tag.

• Right-click the tag and select Edit Tag from the drop-down menu.

 4. On the Edit Tag dialog, modify the tag.

 
Verify that all tag edits are valid. Otherwise, the file could become corrupt.

 5. Click OK.

Edits to the tag are saved.
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MANAGE TAGS

Clear All Tags

 
Use Preferences > General Preferences > Tags to configure tags as full-sized or shortened.

To clear all tags:

 1. Open a file.

 2. In TXLF Editor, and on the Edit tab, click Clear All Tags to expand the drop-down menu.

 3. Select Segment or Document.

Segment or Ctrl-Shift+V Select to clear only the tags from the selected segment.

Document Select to clear all segment tags for all target segments in the file.

A warning message asks you to agree to clear all tags from the open file.

 4. Click Yes.

All tags are cleared for the target segment or for all target segments in the document.

MANAGE TAGS

Delete a Tag
You may choose to delete target tags, particularly if there are multiple copies of the same tag in the same target
segment. You can only delete target segment tags.

To delete a tag:

 1. Open a file.

 2. Follow the steps in Translate a File

 3.  In TXLF Editor, select a tag in a target segment.
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 4. Choose one of the following actions:

• Press Delete or Backspace.

• On the Edit tab, click Cut, then paste the tag elsewhere.

 
To undo the change, click Undo or press Ctrl-z.

The target tag is deleted.

Manage Project Notes
You can add notes that are specific to each segment during the translation and review process. If you have
chained files together, you can review all notes for all files in the chain.

Use the Notes tab in the Editor pane to view and manage project notes.

  To quickly access Notes actions, right-click the segment. Then, select a notes action from the
resulting drop-down list.

MANAGE PROJECT NOTES

View Notes
The Notes tab is in the Editor pane. Notes retain the same ID as the related segment.

 
Segments with notes include a  in the Status column.

To view notes:

 1. Open a file.

 2. In TXLF Editor, click the Notes tab in the Editor Pane, then view note details for all file segments.
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Notes for all file segments are displayed.

MANAGE PROJECT NOTES

Add a Note
To add a note:

 1. Open a file.

 2. In TXLF Editor, select a segment.

 3. Choose one of the following actions:

• Click the Notes tab in the Editor pane, then click Add Note.

• On the Review tab, click Add Note.

 4. On the Add/Edit Notes dialog, select a Type from the drop-down list.



6. Translate or Review Files Wordfast

Copyright © Wordfast, LLC 2018.   Page 82 of 210

Type Description

Translation Select to include data for the reviewer from the translator.

Review Select to includes data for the translator from the reviewer.

Question Select to solicit a response about the segment from a user.

Important Select to flag the data for the segment as a priority for other users.

 5. Enter the information in the note field.

 6. Click OK.

The note is saved and associated with the segment.

MANAGE PROJECT NOTES

Edit a Note
To edit a note:

 1. Open a file.

 2. In TXLF Editor, select a segment with a note.
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 3. Choose one of the following actions:

• Click the Notes tab in the Editor pane, then click Edit Note.

• On the Review tab, click Edit Note.

 4. On the Add/Edit Notes dialog, edit the note.

 5. Click OK.

The modified note is saved and associated with the segment.
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MANAGE PROJECT NOTES

Delete a Note
To delete a note:

 1. Open a file.

 2. In TXLF Editor, select a segment with a note.

 3. Choose one of the following actions:

• Click the Notes tab in the Editor pane, then click Delete Note.

• On the Review tab, click Delete Note.

The note is no longer attached to the segment. If there are no other notes, the notes icon is removed from the
Status column for the segment.

MANAGE PROJECT NOTES

Export Notes
To export notes:

 1. Open a file.
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 2. In TXLF Editor, choose one of the following actions:

• Click the Notes tab in the Editor pane, then click Export Note.

• On the Review tab, click Export Notes.

• Right-click the segment and click Export Notes.

 3. On the Export Notes dialog, browse and select a location for the exported notes file.

 4. Enter a file name and click Save.

All notes for the open file are saved in the selected folder location as a table in either Word DOC or HTML file
format.

Use Transcheck
You can use Transcheck to scan translated content for non-linguistic errors such as missing tags, empty targets,
numbers, and terminology within target segments. The  is displayed in the Status column for segments with
errors.

  To enable Transcheck and customize Transcheck options, configure in Preferences > New Project
Preferences.

USE TRANSCHECK

Use Transcheck During Translation
After you have configured Transcheck options, you can begin using Transcheck when you translate a segment
and commit to the TM. You can also use the Transcheck segments while translating Transcheck configuration
option to check for errors during the translation process.

To use Transcheck during translation:

 1. In TXLF Editor, click a segment and complete your translation of that segment.
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 2. Click Next Segment or press Alt+Down to update the TM, move down one segment, and leverage the next
segment from the TM.

 3. (Optional) If Transcheck identifies an error in the segment, it posts a warning message. Choose one of the
following actions:

• Click Go back to fix the issue to correct the error.

• Click Continue to continue translating without changes.

If you choose to correct the error, the  is removed from the Status column and from the Transcheck tab.

If you do not correct the error, the  remains in the Status column and on the Transcheck tab.

USE TRANSCHECK

Use Transcheck All
Use Transcheck All to scan all segments of a file for non-linguistic errors in the target segments and issue
warnings for missing and incorrect text. Configure and enable your Transcheck preferences under Preferences >
Current Project Preferences > Transcheck.

 
Use the Transcheck All option before you complete a file.

To use Transcheck All:

 1. In TXLF Editor, finish translation of all segments in a file.

 2. Click the Review tab, then click Transcheck All.

A Transcheck report and summary result.

 3. Review the warnings in the Transcheck Summary dialog, then click OK.

 4. (Optional) On the Transcheck Report, determine the terminology errors you want Transcheck to ignore from
highlighted terms in the Terminology Check report section.

 To best optimize the Transcheck Report, you can configure Transcheck to ignore highlighted terms
you identify under conditions you specify. The terms and conditions you select are in the Ignored
Terminology Errors section of the report.
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 5. (Optional) Click a highlighted term.

 6. (Optional) On the Ignore Terminology Transcheck Error dialog, compare the source string with the target
equivalents.

 7. (Optional) Select either When term is for source terms in the glossary or When target contains for target
terms.
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 8. (Optional) Either click Ignore to disregard the single instance of a string or Ignore All to disregard every
instance of a string.

 
The number following Ignore All contains the total number of instances within that file.

 9. (Optional) Review the terms in the Ignored Terminology Errors section of the Transcheck report.
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 10. (Optional) After closing the Transcheck report, select any remaining segments with a  in the Status column.
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 11. (Optional) Click the Transcheck tab to examine the details of the segment error.

 
The total number of errors in the segment is the number in parentheses on the Transcheck tab.

 12. (Optional) Click Next error or Previous error on the Transcheck tab to view the next or prior segment error.

 13. Choose one of the following actions:

• Correct the error and click Refresh to complete the correction.

• Click Ignore warning to continue reviewing error warnings without making any changes.
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If you correct the error, the  is removed from the Status column.

If you do not correct the error, the  remains in the Status column.

Leverage Auto-Propagation
The purpose of auto-propagation is to leverage repetitive segments and re-use content. Configure and enable
your auto-propagation preferences under Preferences > General Preferences > Auto-Propagation.

To leverage repetitive content:

 1. Select a segment for translation in the TXLF Editor. In this example, a filtered search locates and identifies
duplicate segments.

 2. Enter the translation for the first target segment.

 3. Click Next Segment or press Alt+Down to update the TM, move down one segment, and leverage the next
segment from the TM.
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Once you commit the target segment, this action automatically propagates the TM updates to target segments
throughout the file, based on segment preferences.

Leverage Auto-Suggestion
You can use autosuggestion to propose target content based on specific source content, such as numbers, URLs,
and proper names. You can also use it to propose terms for the glossary, translation memory (TM) matches, and
sub-segment TM matches. Configure and enable your autosuggestion preferences under Preferences > General
Preferences > Auto-Suggestion.

Monitor Maximum Segment Length
Based on Project Director (PD) settings, your files may have a set maximum segment length. Any violation of
a segment that exceeds the maximum characters allowed results in a change to the segment Max value in the
progress bar from black to red. In the example, the target segment has 57 characters, when there is a limit of 56.

Users can monitor the progress bar for maximum segment length violations, and can also configure the
Transcheck Report to flag such violations. Refer to Configure Transcheck.

Get an MS Word Table
You can preview and save the file you have open for translation as a bilingual table in MS Word format.

To get an MS Word table:

 1. Select a file with translated content.

 2. On the File tab, click Get MS Word Table.
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 3. On the Get MS Word Table dialog, click Get MS Word Table.

 You can configure MS Word Table settings by clicking the hyperlink to the Preferences location. If
you want to disable the dialog, select Don't show this dialog anymore. If you need to re-enable
the warning dialog, select Show dialog to configure MS Word Table Preferences from General
Preferences > Warnings.

The file downloads as a Microsoft Word document containing a bilingual table of source and target segments.

 4. (Optional) Review the resulting file for completeness.

Preview a File
Use Preview to display the source content in its original format, such MS Office, HTML, InDesign, and SDL
source formats.

To preview files:

 1. Open a file in TXLF Editor.

 2. On the File tab, click Preview File.
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The preview of the source content is displayed in its original format.

Use Live Preview
You can view the translated content in its original format for MS Word .DOC and .DOCX files or MS
PowerPoint .PPT and .PPTX files.

Use the default Live Preview to generate a dynamic preview of the translated file in TXLF Editor.

  To configure and enable the Live Preview preference under General Preferences > General, select
Automatically open Live preview for supported files.

To generate a live preview:

 1. Open a file in TXLF Editor.

 2. On the File tab, select Live Preview from the Preview drop-down menu.

 
Only one preview option is possible at a time.

 3. (Optional) Interact with the live preview of the file.

For MS Word files
The preview pane docks to the right. Click  for
docking options. Live Preview highlights the active
segment. Move to any other segment by clicking on
that area of the live preview.
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For MS PowerPoint files
PowerPoint files can be graphically intensive and so
may take time to load. The progress bar provides
real-time loading status. Click  to cancel the Live
Preview.

• Docking — The preview pane docks to the
right. Click  for docking options. Live Preview
highlights the active segment. Move to any
other segment by clicking that area of the live
preview.

• Slide Access — Click the forward or back
arrow to progress through the slide deck or
type the deck slide number in the Page field.
To return to the first slide in the deck, click .

 4. Enter the translation or leverage the TM for any segment.

 5. On the Translation tab, click Next Segment or press Alt+Down to update the TM, move down one segment,
and leverage the next segment from the TM.

The new translation is displayed. To collapse or expand the live preview pane, click  or .

 6. (Optional) Click Synchronize Live Preview on the File tab to refresh the pane.

Save a File
As you work on a file, frequently save your changes to a local folder .

To save your work:

 1. Click the File tab, if you are not already on it.

 2. In TXLF Editor, click either Save or a Save Options action.

Save File As Translated Select to save the active file to a local folder.

Save Select to save the active file to a local folder with the existing filename.

Save As Select to save the active file to a local folder under a different name.

A progress bar is displayed. After successful completion, the file is updated in a local folder.
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7. Leverage Project TMs
A translation memory (TM) provides maximum content re-use and facilitates collaboration among localization
resources. Users can leverage reusable content using one of two different types of TMs.

  Consider using a free, hosted service: WordFast Anywhere (WFA). WFA allows translators to connect
to a shared server and interact with a private, remote TM and glossary.

Local TM Located on your local computer system and only you can access it.

Remote TM Located on a server that other translators can access. This allows multiple
translators to leverage the available content and update the TM with new reusable
content.

  You can remove a TM from a project so it is no longer in the project TM list. When you remove a local
TM from a project, it remains in the TM folder on your computer system. To add a removed local TM
back to the project, use the Add Local action on the Project TM tab. To add a removed remote TM
to the project, use the Connect to Remote action on the Project TM tab.

Create a Local TM
Create a local translation memory (TM) for quick, local access. If it is possible you may need to share your TM
with other users, connect to a free, hosted service: Wordfast Anywhere (WFA). Refer to Connect To a Remote
Glossary.

To create a local TM:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Project TM tab, click Create Local.

 3. On the Translation Memory dialog, enter the required TM configuration.

 
Required fields are marked with a red asterisk.
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Field Action

Name Enter a unique TM name that includes the client or organization name and the
TM's language for easy identification.

Target Language Select target languages. Target languages are limited to those languages
configured in the project.

Location Select the destination where the application saves the new TM.

Priority Set the TM sequence used during translation, using the Primary TM first,
followed by any Secondary TMs.

Note: You can only select one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Read-Only (Optional) Select to leverage the TM without updating it with the new translation.

 4. Click OK.

The new TM is created and is displayed in the Project TM list.

Add a Local TM to a Project
You can add a local TM to your project at the time of creation or as a separate action.

  You can add TMs created by Wordfast Pro 4 or 5 only. If you want to add TMs from Wordfast Classic
or Wordfast Pro 3, use the Import TM option.

To add a local TM to a project:

 1. On the Projects tab, double-click a project from the projects list.

 2. Click the Project TM tab, then click Add Local.
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 3. On the Opening TM dialog, browse to the local TM folder and select it.

 4. Click Select Folder.

The selected TM is added to the project and displayed in the Project TM list.

Add Project TMs
Some projects may use multiple local and remote translation memories (TMs). In such instances, it is more
efficient to add all of the TMs for the project with a single Add Project TMs action.

To add project TMs:

 1. On the Projects tab, double-click a project from the projects list.

 2. On the Project TM tab, click Add Project TMs.

 3. On the Add Project TMs dialog, enter the project TM information.

Field Action

Select a Project Select a project name from the drop-down list.

Source Language Leave the auto-populated source language.
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Field Action

Target Language(s) Leave the auto-populated target languages.

List of TMs Review the list of TMs associated with that project.

 4. Click OK.

The selected project TMs are added to the project and are displayed in the Project TM list.

Connect to a Remote TM
You can connect to one or more translation memories (TMs) on other computers, including a free, hosted service:
Wordfast Anywhere (WFA).

  Wordfast Anywhere allows translators to connect to a shared server and interact with a private,
remote TM and glossary.

To connect to a remote TM:

 1.  On the Projects tab, double-click a project from the projects list to open it.

 2. On the Project TM tab, click Connect To Remote.

 3. On the Connect to Remote TM dialog, select the appropriate tab, based on your server options.

• TM Server

• WF Server

• WFA Server

 4. (Optional) Add a TM Server on the TM Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.
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Field or Option Action

Symbolic Name Enter a unique name for the TM.

URL Enter the remote TM URL using the following format: tm://address:port/
TMS?. The remaining URL Settings automatically populate when you enter the
URL string. Click Test to validate the connection.

TM Cleanup Passcode Enter the password to update the TM for the project.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Read Only (Optional) Select to leverage the TM without updating it with the new translation.

 5. (Optional) Add a WF Server on the WF Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.
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Field or Option Action

Symbolic Name Enter a unique name for the TM.

URL Enter the remote TM URL using the following format: wf://
jsmith.password@address:port/TMS?. The remaining URL Settings
automatically populate when you enter the URL string.
(Optional) The Password and Workgroup ID fields depend on server settings.
Click Test to validate the connection.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Use TM Write Password (Optional) Require a password to clean up target content and update the TM.
Include the password in the TM Write Password field after selecting this option.
If a password is not set in the WF Server, then select the checkbox, but leave the
field empty.

Read Only (Optional) Select to leverage the TM without updating it with the new translation.
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 6. (Optional) Add a WFA Server on the WFA Server tab, complete the required fields, then click OK.

Field or Option Action

Symbolic Name Enter a unique name for the TM.

API Key Enter the API key you obtain from WFA.

1. Log in to your free WFA account at https://www.freetm.com.
2. Click TMs & Glossaries, then Setup.
3. On the TMs and glossaries management dialog, select a TM or

Glossary.
4. Click Manage Sharing.
5. On the TMs and glossaries shares dialog, click the API key and copy the

text string.
6. Paste the API key into the Connect to Remote TM dialog using the

following format: username@1234567, then click Test to validate the
connection.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Read Only (Optional) Select to leverage the TM without updating it with the new translation.

The new TM is added to the project and is displayed in the project TM list.

Open and Edit a Local TM
You can open and edit local translation memory (TM) entries at any time after TM creation.
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You cannot open a remote TM in TM Editor.

To open and edit a local TM:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Project TM tab, select a translation memory and click Open TM.

 3. On the TM Editor tab, view the translation units (TUs) for both source and target languages.

 4. (Optional) To search for source or target translation units (TUs), enter your search criteria in the appropriate
fields in the Filters sidebar, then click Find.
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 You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

 5. (Optional) To reset your search criteria, click Clear.

 6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit a TM entry.

Modify a TM
To rename, write-protect, or change the priority of a TM, use the Modify TM action.

To modify a local or remote TM:

 1.  On the Projects tab, double-click a project from the projects list.

 2. On the Project TM tab, click a TM.

 3. Click Modify TM.

 4. On the Connect to Remote TM dialog, modify the details for your connection. Based on your selection, other
fields auto-populate. Refer to Connect to a Remote TM.

 
You can only select one primary TM for a project.

Required fields are marked with a red asterisk.
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 5. (Optional) Select the TM identified in the Name field for the current project using Selected.

 6. (Optional) Select Read-only to allow users to leverage the TM but not update it with new translation.

 7. Click OK.

Your modifications to the TM are saved.

Copy a Local TM
Copy a TM to use an existing TM for a new project.

 
The copied TM is in the Wordfast Pro TM format, regardless of the original TM format.

To copy a local translation memory:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Project TM tab, select a translation memory and click Copy TM.



7. Leverage Project TMs Wordfast

Copyright © Wordfast, LLC 2018.   Page 106 of 210

 3. On the Copy Translation Memory dialog, enter the TM Name.

 
Required fields are marked with a red asterisk.

 4. Browse and select the Location on your disk for the TM copy.

 5. (Optional) Select Flip Languages, to reverse the source and target languages, then click Copy.

A copy of the translation memory is saved in the selected folder location.

Import a Local TM
To use a local translation memory (TM) from another linguist, use the Import TM action.

To import a local TM:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. Click Import TM on the Project TM tab.

 3. On the Import Translation Memory dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.



7. Leverage Project TMs Wordfast

Copyright © Wordfast, LLC 2018.   Page 107 of 210

Field Action

File Type Select an action from the drop-down list.

• TMX — Translation Memory eXchange file format provides compatibility
with all translation tools.

• WF TXT TM format (.txt) — File format provides backward compatibility
for Wordfast Classic and Wordfast Pro 3.

Import File Browse to select the file for import.

Create New TM Click to import the TM into a new TM file.

Import into Existing TM Click to import the TM into an available TM file, based on selection from the drop-
down list.

Existing TM Select an available TM file from the drop-down list.

If TU already exists Select a TM option from the drop-down list to import it into an available TM file.

Delete all TUs from
existing TM

Select to delete the existing TM and replace it with the new TM.

 4. Click OK.

The translation memory is imported and is displayed in the Project TM list.

Export a Local TM
To share a local translation memory (TM) with another linguist, use the Export TM action.

To export a local TM:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. Select a TM assigned to that project.
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 3. Click Export TM on the Project TM tab.

 4. On the Export Translation Memory dialog, choose a location and export type for the TM export file.

 
Required fields are marked with a red asterisk.

Translation Memory Select a TM from the drop-down list.

Export Type Select the export file type from the drop-down list.

File Location Browse and select the folder location for the export.

 5. Click OK.

The selected translation memory exports to the selected folder location.
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8. Leverage Project Terminology Lists
Terminology is a phrase used to identify two distinct groupings: the glossary and the blacklist.

• Glossary—A database of preferred source terms, words, and phrases paired with their target equivalents
designated as preferred and client-specific

• Blacklist—A database of rejected target terms prohibited from use in the translation

Leverage Project Glossaries
A glossary includes source terms and a correlated list of preferred target terms.

LEVERAGE PROJECT GLOSSARIES

Create a Local Glossary
To create a local glossary:

 1. On the Projects tab, double-click a project from the projects list.

 2. On the Project Terminology tab, click Create Local.

 3. On the Create Glossary dialog, enter the glossary information.

 
Required fields are marked with a red asterisk.

Field Action

Name Enter a unique name for the glossary.

Source Language Do nothing, since the source language auto-populates.
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Field Action

Target Language Select a language from the target languages available for your project in drop-
down list.

Location Browse and select the folder location for the new glossary.

Selected (Optional) Select to use the current local glossary for the project.

Read Only (Optional) Select to leverage the glossary without updating it with new terms.

 4. Click OK.

The new glossary is displayed in the project glossary.

LEVERAGE PROJECT GLOSSARIES

Add a Local Glossary
You can only add glossaries created by Wordfast Pro 4 or 5. For glossaries from Wordfast Classic or Wordfast
Pro 3, use the Import Glossary action. Refer to Import a Local Glossary.

To add a local glossary:

 1. On the Projects tab, double-click a project from the projects list.

 2. On the Project Terminology tab, click Add Local.

 3. On the Creating Glossary finder, browse to a glossary folder and select it.

 4. Click Select Folder.

The selected glossary is added to the project and is displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Add Project Glossaries
Some projects may use multiple local and remote glossaries. In such instances, you can add all of the glossaries
from a previous project with a single Add Project Glossaries action.

To add project glossaries:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Project Terminology tab, click Add Project Glossaries.
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 3. On the Add Project Glossaries dialog, enter the project glossaries information.

Field Action

Select a Project Select a project name from the drop-down list.

Source Language Leave the auto-populated source language, based on the project.

Target Language(s) Leave the auto-populated target languages, based on the project.

List of Glossaries Review the list of glossaries associated with that project.

 4. Click OK.

The selected project glossaries are added to the project and displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Connect To a Remote Glossary
You can connect to a glossary residing on another server, including a free hosted service: Wordfast Anywhere
(WFA).

  Wordfast Anywhere allows translators to connect to a shared server and interact with a private,
remote translation memory (TM) and glossary.

To connect to a remote glossary:

 1. On the Projects tab, double-click a project from the projects list.

 2. On the Project Terminology tab, click Connect To Remote from the Terminology group.
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 3. On the Connect to Remote TM dialog, select the appropriate tab, based on your server options.

• TMGR Server

• WF Server

• WFA Server

 4. (Optional) Add a Term Manager (TMGR) Server on the TMGR Server tab, complete the required fields, then
click OK.

 
Required fields are marked with a red asterisk.

Field or Option Action

Name Enter a unique name for the glossary.

Target Language Select a language from the drop-down list. This list is constrained by the available
target languages for your project.

URL Enter the remote glossary URL using the following format: tmgr://
address:port/TMGR?.

Note: The remaining URL Settings automatically populate when you enter the
URL string. This includes the username, password, and project short code.
Click Test to validate the connection.

Selected (Optional) Select to use the current glossary for the project.
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Field or Option Action

Read Only (Optional) Select to leverage the glossary without updating new terms.

Create Blacklist
Connection

(Optional) Select to connect to an available blacklist already in TMGR.

 5. (Optional) Add a WF Server on the WF Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.

Field or Option Action

Name Enter a unique name for the glossary.

Target Language Select a language from the drop-down list. This list is constrained by the available
target languages for your project.

URL Enter the remote glossary URL using the following format: wf://
jsmith:password@address:port/tmgr?. The remaining URL Settings
automatically populate when you enter the URL string. Click Test to validate the
connection.

Address Enter the address associated with the URL.

Port Enter the port associated with the URL.

Username Enter the username associated with the URL log in.

Password (Optional) Enter the password associated with the username.
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Field or Option Action

Workgroup ID (Optional) Enter the workgroup ID for the project.

Selected (Optional) Select to use the current glossary for the project.

Read Only (Optional) Select to leverage the glossary without updating new terms.

 6. (Optional) Add a WFA Server on the WFA Server tab, complete the required fields, then click OK.

Field or Option Action

Name Enter a unique name for the glossary.

Target Language Select a language from the drop-down list.

Note: This list is constrained by the available target languages for your project.

API Key Enter the API key you obtain from WFA.

1. Log in to your free WFA account at https://www.freetm.com.
2. Click on TMs & Glossaries, then Setup.
3. On the TMs and glossaries management dialog, select a glossary.
4. Click Manage Sharing.
5. On the TMs and glossaries shares dialog, click on the API key and copy

the text string.
6. Paste the API key into the Connect to Remote Glossary dialog on the

WFA Server tab using the following format: username@1234567, then
click Test to validate the connection.

Selected (Optional) Select to use the current glossary for the project.

Read Only (Optional) Select to leverage the glossary without updating new terms.

The selected glossary is added to the project and is displayed in the project Glossaries list.
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LEVERAGE PROJECT GLOSSARIES

Open and Edit a Local Glossary
You can open and edit local glossary entries at any time after glossary creation.

 
You cannot open a remote glossary in Wordfast Pro.

To open and edit a local glossary:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Project Terminology tab, select a local glossary, and click Open Glossary.

 3. In the Glossary Editor, view the terms for both source and target languages. You can also filter, add, remove,
and update terms.

 4. (Optional) To search for source or target terms, enter your search criteria in the appropriate fields in the Filters
sidebar, then click Find.



8. Leverage Project Terminology Lists Wordfast

Copyright © Wordfast, LLC 2018.   Page 116 of 210

 You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

 5. (Optional) To reset your search criteria, click Clear.

 6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste within the source and target columns.

LEVERAGE PROJECT GLOSSARIES

Import a Local Glossary
To exchange glossaries with other translators, save the exported glossary to a local drive, then use the Import
Glossary action to import it to your project.

 
To exchange glossaries among projects on your local drive, use the Add Project Glossaries action.

To import a local glossary:

 1. On the Projects tab, double-click a project from the projects list.

 2. Click Import Glossary on the Project Terminology tab.

 3. On the Import Glossary dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.
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Field Action

File Type Select a file format for importing raw text files.

• Term Base eXchange (TBX) — Use with other CAT tool glossaries

• Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast
Pro glossaries

Import File Click Browse to locate and select an Import File.

Create a new glossary Click to use the imported glossary to create a new glossary rather than add terms
to an existing glossary.

Import into existing
glossary

Click to use the imported glossary to add to the selected glossary.

Existing Glossary Select from the drop-down list to append the imported glossary to an existing
glossary file.

If term already exists Select from the drop-down list to import the term into an existing glossary file.

• Add as a new term — Add the term to the existing glossary file.

• Do not overwrite — Ignore the term and retain the term already in the
glossary file.

• Overwrite existing term — Use the new term to replace the term already
in the glossary file.

Delete all terms from
existing glossary

Select to delete the existing term and replace it with the new glossary term.

 4. Click OK.

The glossary is imported and is displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Export a Local Glossary
To exchange glossaries with other translators, use the Export Glossary action and save it to a local drive, then
send it to another translator to import to their project.

 
To exchange glossaries among projects on your local drive, use the Add Project Glossaries action.

To export a local glossary:

 1. On the Projects tab, double-click a project from the projects list.

 2. On the Project Terminology tab, select a glossary and click Export Glossary.
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 3. On the Export Glossary dialog, select a glossary from the drop-down list.

 4. Select the file Export Type from the drop-down list.

• Term Base eXchange (TBX) — Use with other CAT tool glossaries

• Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast Pro 3 glossaries

 5. Click Browse to locate and select the export file location, then click Save.

 6. Click OK.

The glossary is exported to the specified file location.

Leverage Project Blacklists
You can use a blacklist to exclude words or phrases from use in the target segment.

LEVERAGE PROJECT BLACKLISTS

Create a Local Blacklist
You can create a blacklist for your project on your local computer.

To create a local blacklist:

 1. On the Projects tab, double-click a project from the projects list.

 2. On the Project Terminology tab, click Create Local in the Blacklist group.

 3. On the Create Blacklist dialog, enter the required blacklist information.

 
Required fields are marked with a red asterisk.
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Field Action

Name
Enter a unique blacklist name that includes the client or organization name and the
blacklist target language for easy identification.

Language
Select the blacklist's target language, which is limited to languages configured in
the project.

Location Select the destination for the new blacklist.

Selected (Optional) Select to use the current blacklist for the project.

Read-Only (Optional) Select to leverage the blacklist without updating it with the new
translation.

 4. Click OK.

The new blacklist is created and is displayed in the project terminology list.

LEVERAGE PROJECT BLACKLISTS

Add a Local Blacklist
Use a local blacklist already created on your computer when you want to leverage a translation blacklist, but do
not want to collaborate with other users. You can add a local blacklist to your project at the time of creation or as a
separate action.

To add a local blacklist:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Project Terminology tab, click Add Local in the Blacklist group.

 3. On the Creating Blacklist finder, browse to a blacklist file and select it.

 4. Click Select Folder.



8. Leverage Project Terminology Lists Wordfast

Copyright © Wordfast, LLC 2018.   Page 120 of 210

The selected blacklist is added to the project and is displayed in the project terminology list.

LEVERAGE PROJECT BLACKLISTS

Connect to a Remote Blacklist
You can connect to one or more blacklists on another computer or server.

To connect to a remote blacklist:

 1. On the Projects tab, double-click a project from the projects list.

 2. On the Project Terminology tab, click Connect To Remote from the Blacklist group.

 3. On the Connect to Term Manager dialog, enter the required information, based on your server options.

Required fields are marked with a red asterisk.

Field or Option Action

Name Enter a unique name for the blacklist.

Target Language Select a target language from the drop-down list.

URL Enter the remote TMGR URL using the following format: tmgr://
address:port/TMS?. The remaining URL Settings automatically populate
when you enter the URL string. Click Test to validate the connection.

Address Enter the remote address.
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Field or Option Action

Username Enter the username associated with the URL log in.

Password Enter the password associated with the username.

Project Short Code Enter the short code for the project, such as ABC0000001.

Selected (Optional) Select to use the current blacklist for the project.

 4. Click OK.

The new remote blacklist is displayed in the project terminology list.

LEVERAGE PROJECT BLACKLISTS

Open and Edit a Local Blacklist
You can open and edit local blacklist entries at any time after blacklist creation.

 
You cannot open a remote blacklist in Wordfast Pro.

To open and edit a local blacklist:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Project Terminology tab, select a local blacklist, and click Open Blacklist.

 3. On the Blacklist Editor tab, view the blacklist terms for both source and target languages. You can also filter,
add, remove, and update terms.
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 4. (Optional) To search for source or target blacklist terms, enter your search criteria in the appropriate fields in
the Filters sidebar, then click Find.

 You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

 5. (Optional) To reset your search criteria, click Clear.

 6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit entries within the forbidden
and suggested term columns.

LEVERAGE PROJECT BLACKLISTS

Import a Local Blacklist
To use a local blacklist from another source, use the Import Blacklist action.

To import a local blacklist:

 1. On the Projects tab, double-click a project from the projects list.

 2. Click Import Blacklist on the Project Terminology tab.

 3. On the Import Blacklist dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Field Action

File Type Select TXT as the file format for importing raw text files.
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Field Action

Import File Click Browse to locate and select an Import File.

Create a new blacklist Click to use the imported blacklist to create a new blacklist, rather than add terms
to an existing blacklist.

Import into existing
blacklist

Click to use the imported blacklist to add to the selected blacklist.

Existing Blacklist Select from the drop-down list to append the imported blacklist to an existing
blacklist file.

If term already exists Select from the drop-down list to import the term into an existing blacklist file.

• Add as a new term — Add the term to the existing blacklist file.

• Do not overwrite — Ignore the term and retain the term already in the
blacklist file.

• Overwrite existing term — Use the new term to replace the term already
in the blacklist file.

Delete all terms from
existing Blacklist

Select to delete the existing term and replace it with the new blacklist term.

 4. Click OK.

The blacklist is imported and displayed in the project Blacklist.

LEVERAGE PROJECT BLACKLISTS

Export a Local Blacklist
To share a local blacklist with another linguist, use the Export Blacklist action.

To export a local blacklist:

 1. On the Projects tab, double-click a project from the projects list.

 2. Select a blacklist from the project Blacklist on the Project Terminology tab.

 3. Click Export Blacklist on the Project Terminology tab.

 4. On the Export Blacklist dialog, choose a blacklist name, export type, and folder location for the blacklist
export file.

 
Required fields are marked with a red asterisk.
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Blacklist Select a blacklist from the drop-down list.

Export Type Select the export file type from the drop-down list.

File Location Browse and select the folder location for the export file.

 5. Click OK.

The selected blacklist exports to the selected folder location.

Use Project Terminology Options
You can use the Options group of the Project Terminology tab to modify and remove glossaries and blacklists.

USE PROJECT TERMINOLOGY OPTIONS

Modify a Glossary or Blacklist
To modify a glossary or blacklist:

 1.  On the Projects tab, double-click a project from the projects list.

 2. On the Project Terminology tab, click a glossary or blacklist.

 3. Click Modify.

 4. On the Create Glossary dialog, modify the details as required. Based on your selection, other fields auto-
populate.

 
Required fields are marked with a red asterisk.
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Name Modify the name of the current blacklist or glossary.

Selected (Optional) Select to use the current blacklist or glossary for modification.

Read Only (Optional) Select to leverage the glossary or blacklist without updating it with the new
translation.

 5. Click OK.

Your modifications are saved.

USE PROJECT TERMINOLOGY OPTIONS

Remove a Glossary or Blacklist
When you remove a glossary or blacklist from a project, the glossary or blacklist file remains in the glossary or
blacklist folder on your computer. You can add it again with the Add Local or Connect to Remote action.

To remove a glossary or blacklist:

 1. On the Projects tab, double-click a project from the projects list.

 2. On the Project Terminology tab, select a glossary or blacklist.

 3. Click Remove.

A warning message asks you to agree to the removal.

 4. Click Yes.

The selected glossary or blacklist is removed from the project terminology list.
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9. Monitor Reports
Use the Reports tab to open and to export auto-generated analysis and cleanup reports to .CSV, .HTML, .XLS,
and .PDF formats.

Open a Report
Use the Open Report action to open and view an auto-generated report.

To open a report:

 1. On the Reports tab, select a report.

 2. Double-click the report file name.
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 3. Review the report, then click OK to close the dialog.

Export a Report
You can export an auto-generated report to a CSV, HTML, XLS, or PDF file format before you view it.

To export a report:

 1. On the Reports tab, select a report.

 2. Select a format from the Export drop-down list.

 3. Browse to the location for the report, enter a file name, and click Save.

The report is saved to the designated location.
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10. Manage Project Reference Files
You can include reference files in a project to provide context. Typical reference files are additional instructions,
illustrations, workflow diagrams, certifications, or any file that might aid translators and reviewers. Reference files
remain untranslated.

 
Users cannot modify reference files once you attach them to the project.

Add Reference Files
To add reference files:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Reference Files tab, click Add Files.

 3. On the Open dialog, browse and select the reference file. To select multiple reference files, press Ctrl and
select them.

 4. Click Open.

The files are added to the reference files list for the project.

Open a Reference File
To open a reference file:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Reference Files tab, select a reference file from the list.

 3. Click Open File.
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The selected file is opened.

View Submission Instructions
Submitters can include instructions as part of the Package files imported into Wordfast Pro.

To view instructions:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Reference Files tab, click Show Instructions.

 3. In the Instructions dialog, review the instructions on the first Instructionstab, then click the Background
Instructions tab for any project-related or more general information and instructions.

 4. Click OK.

The Instructions dialog is closed.

Remove a Reference File
You can remove a reference file from a project, but the file remains on your local computer.

 
To add a removed reference file, use the Add Files action on the Reference Files tab.

To remove a reference file:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Reference Files tab, select the files you want to remove.

 3. Click Remove File(s).

 4. On the Remove dialog, select one of the available buttons.
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Remove from the list only Removes the reference file from the files list, but
retains the reference files resources in the project
folder on your computer

Remove from the list and move the following
resources to Archive folder

Removes the reference file from the files list and
moves them to the archive folder inside the project
folder on your local computer

 5. Click OK.
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11. Use Quick Tools
You can use Quick Tools to create and work with files outside of projects. Typically, Project Managers use Quick
Tools before cleaning up and sending files on to translation.

 
Access the Quick Tools view from the drop-down menu on the Wordfast Pro tab.

  For Analyze and Cleanup actions, you can choose to run the action in the background and continue
your work. This is useful when processing large numbers of files.

Analysis
You can use actions on the Analysis tab to submit files to assess potential TM matches and repetitions.

  When you first open Quick Tools, the default is the Analysis tab. Once you access Quick Tools, the
default Quick Tools tab is the last one you used.

  For Analyze and Cleanup actions, you can choose to run the action in the background and continue
your work. This is useful when processing large numbers of files.

To analyze files:

 1. Click the Wordfast Pro drop-down menu and select Quick Tools.
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 2. Click the Analysis tab, if it is not already selected.

 3. Click Add Files to browse and select a file from a folder or click Add Folder to browse and select a folder and
all its files.

 
To add multiple files, press the Ctrl key and select the files.

 
You can also drag and drop files into the Source Files pane.

 4. (Optional) Add and select a Translation Memory.

 
If you do not select a TM, the analysis report displays the word count without TM leverage.

 5. Select the Source Language and Target Languages.

 6. (Optional) For the Analyze Options of the report, select Pretranslate, select the baseline match percentage
for the TM leverage from the spin box, then the type of match from the next drop-down list.

• Copy segment source to target when there is no match — When there is no matching target
content, insert source content in its place.
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• Copy all tags on segments when there is no match — When there is no matching target content,
insert source tags in its place.

• Do nothing for no match

 7. If you choose to configure Analyze options, you must select a Create TXLF files option from the drop-down
list.

• Next to source with target language suffix

• Inside subfolder and maintain folder structure for folders

• Do not create TXLF

 8. Select Report Settings.

• Select Words or Segments as the means of calculating analysis percentages from the drop-down list.

• (Optional) Select Calculate internal fuzzy matches according to the match percentage you set or
select an alternate percentage.

• (Optional) Select Include internal fuzzy matches as TM matches.

• Select the report format from the drop-down list, then browse and select a location for the report on your
local computer.

 9. Click Analyze.

 10. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then click Run in Background.

 11. If you chose to run Analyze in the background, you can monitor its progress.

 If you choose to run more than one batch action in the background, each action will have its own
progress bar.

 12. When you receive notification of successful completion, click View Report.
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The Report File dialog is displayed and the report summary in the chosen format is saved to your computer.

Cleanup
To convert bilingual TXLF files to their original source format in the target language, use the Cleanup action.
Refer to Translate Segments.

 
Cleanup updates the translation memory (TM).

  For Analyze and Cleanup actions, you can choose to run the action in the background and continue
your work. This is useful when processing large numbers of files.

To clean up a bilingual TXLF file:

 1. Click the Wordfast Pro drop-down menu and select Quick Tools.

 2. Click the Cleanup tab, if it is not already selected.
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 3. Choose one of the following actions:

• Click Add Files to browse and select a file from a folder.

• Click Add Folder to browse and select a folder and all its files

 4. Add and select a Translation Memory.

 
To better understand context matches or the TM, refer to Leverage Project TMs.

 5. (Optional) Select TM Update Options:

• Update Option — Select one of the TM update options from the drop-down menu: Append, Do not
add to TM, Do not overwrite TU, Overwrite existing TU, or Overwrite if attributes are identical.

• Add attribute — Select and enter an attribute to write to the TM for the cleaned up segments.

• Add file name as an attribute — Select to add the TXLF file name as an attribute to write to the TM for
cleaned up segments.

• Overwrite private TUs (WFServer TM only) — Select to replace existing private TUs with new ones.
This requires a Cleanup password.

• Write 'unedited fuzzy' to TM — Select to write fuzzy matches to the TM without user modification.

• Write 'unedited autopropagated fuzzy' to TM — Select to write automatically inserted fuzzy matches
to the TM without user modification.

• Write 'exact' matches to TM — Select to write context matches to the TM without user modification.

• Write 'unedited MT' to TM — Select to write machine translation to the TM without user modification.

 6. Select a Translated File Settings option for translation file creation from the drop-down list.
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• Next to source with target language suffix — Saves translated files in the same location as the
source TXLF files, in original format, after appending the target language code to the file name as a
suffix.

• Inside subfolder and maintain folder structure for folders — Saves translated files in the same
location as your TXLF files, but in a subfolder that retains the source folder hierarchy.

• Do not create translated files — Prevents the creation of translated files, but retains the source TXLF
files.

 7. Click Cleanup.

 8. (Optional) On the Progress Bar dialog, you can select Always run in the background to preserve the
background batch action for future analysis actions, then click Run in Background.

 9. If you chose to run Cleanup in the background, you can monitor its progress.

 If you choose to run more than one batch action in the background, each action will have its own
progress bar.

The bilingual TXLF file is converted to its original source format in the target language.

Pseudo Translation
You can copy the source content to the target content as a pseudo translation for target languages. Pseudo
translations are of use when the content has accented characters and the text expands by twenty percent or
more. Pseudo translation provides a preview of translatable content and any formatting complexities in the target.

 
You can pseudo translate source or TXLF files.

  If you are using Demo Mode, the limit on processing pseudo translation is 20 files. To pseudo
translate more than 20 files simultaneously, obtain a Wordfast Pro license.

To pseudo translate files:

 1. Click the Wordfast Pro drop-down menu and select Quick Tools.

 2. Click the Pseudo Translation tab.
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 3. Select either the TXLF or Source file type for pseudo translation.

 4. In the Language Selection pane, select a Source Language and Target Language.

 5. (Optional) In the Pseudo translation Options pane, select either or both options for creating the target file
and adding a suffix to the filename, then click an option to either save it to the original location or to browse
and select an alternate location.

 6. Click Add Files to browse and select a file from a folder. Click Add Folder to browse and select a folder and
all its files.

 To add multiple files, press the Ctrl key and select the files. You can also drag and drop files into the
Source Files pane.

 7. Click Pseudo Translate.

A successful completion message is displayed.

Quick Tools Bilingual Export
Use Bilingual Export to export the TXLF file with highlighted glossary terms to a .DOC or .DOCX format for edit
and translation of the content using Microsoft Word (Word).
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  You must not edit the export table format. This includes merging or expanding segments and adding
text outside of the target or notes column. Editing the export table format will result in errors during
bilingual import.

To conduct a Quick Tools bilingual export:

 1. Click the Wordfast Pro drop-down menu and select Quick Tools.

 2. Click the Bilingual Export tab.

 3. Click Add Files to browse and select a TXLF file from a folder or click Add Folder to browse and select a
folder and all its files.

 4. Click Add Local to browse and select a local glossary file from a folder or click Connect To Remote to browse
and select a remote glossary.

 5. (Optional) Click Add Project Glossaries to browse and select a glossary associated with a specific project to
add to the available Glossaries list.

 6. Select the TXLF files and glossaries for bilingual export from each list.

 7. Select your Bilingual Export Options from the drop-down list.
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Option Action

Export Type Select an export type option from the drop-down list:

• Bilingual Review Export — Creates a bilingual Word document.

• WFC Bilingual Export (Export only) — Creates a Wordfast
Classic compatible document solely for export.

• MSWord Table — Creates a Word document with the source and
target in a two-column table.

• Bilingual Review Export - WFC (allows import) — Creates a
bilingual Word document for import by Wordfast Classic users.

Open report after export Select to automatically display the Export Report after a bilingual export.

Exclude the notes column Select to remove the Notes column from the exported Word document.
Instead, the export includes the notes from the TXLF file as Comments
in the Word document.

Track changes Select to track changes in the exported Word document.

Protect document (Word 2003+) Select to only allow content edits in the available table space.

Note: This helps avoid any import errors.

Export all TXLF files as one
bilingual file

Select to export all converted TXLF files into a single bilingual Word
document.

Export as Docx Select to export bilingual file to a .DOCX Word file format.

Bilingual File Location Select to set the folder location for bilingual exports.

 8. Click Bilingual Export
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The bilingual export log is displayed and saved to the specified folder on your local computer.

The exported document is also saved to the specified folder on your local computer.
 

Quick Tools Bilingual Import
Use Bilingual Import to re-import your translated or edited Microsoft Word bilingual export document.

  You must upload both the translated or edited bilingual Word document and the source TXLF file you
used during export.

  Since imports overwrite content from the export, create a backup of the original TXLF file for
reference.

  • For bilingual files, the first number in the Counter column indicates the count of TXLF files
in the bilingual file that are paired with the added files in the TXLF Files panel. The second
number indicates the total count of TXLF files that were used during Bilingual Export.

• For TXLF Files, when the bilingual Word document and the corresponding TXLF file are paired,

a  is displayed. If the files are not paired, a  is displayed.

To complete bilingual import of files:

 1. Click the Wordfast Pro drop-down menu and select Quick Tools.

 2. Click the Bilingual Import tab.
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 3. Click Add Files to browse and select a TXLF file from a bilingual export folder, such as Sample.txlf.doc,
and add it to the Bilingual Files list.

 You must select the correct file format from the drop-down list. Select MS Word Document when
uploading the bilingual Word document and WF TXLF Document when uploading the TXLF file.

 4. (Optional) Click Add Folder to browse and select a folder and all its files from a bilingual export folder to add
to the available TXLF Files list.

 5. Select the Bilingual Files and TXLF Files from each list for bilingual import.

 
To select multiple files, press the Ctrl key during selection.

 6. Select your Bilingual Import Options.

Open report after import Select to automatically open a report after bilingual import

Accept Tracked Changes Select to accept tracked changes in a bilingual Word document

 7. Click Bilingual Import.
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The bilingual import log is displayed. The translations and edits in the bilingual export Word document are
imported into the specified TXLF file on your local computer.

 
The import overwrites the TXLF file content with the imported bilingual Word document content.
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12. Configure Preferences
You user preference options control the functions available to you in the user interface. Configure preferences at
either the project level or the file level.

Preferences fall into three primary categories:

• General Preferences

• Current Project Preferences

• User Preferences

General Preferences
Use General Preferences to configure user interface and TXLF Editor preferences.

GENERAL PREFERENCES

Configure Color Settings
Colors preferences control color customization for specific types of content in TXLF Editor.

To configure colors used in the translation table:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Colors under General Preferences.
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 3. Click the color box for any Item Name, then select another color from the color palette on the Color Picker
dialog.

 4. Click OK to close the dialog.

 5. Click OK.

GENERAL PREFERENCES

Configure General Settings
General preferences link a specific username to project-related content changes.

To customize general settings:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click General under General Preferences.
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 3. Enter the User Name for user identification on notes, TM, and segment changes.

 4. Select one of the source file locations.

Option Action

Copy Source or TXLF Files into Project Folder
Structure

Click to create a sub-folder within the project
language folder for storing source files.

Note: If the source file is a TXLF file, a copy is saved.

Create TXLF File with language suffix next to the
Source File

Click to create a TXLF copy of the source file at the
same location with the target language code as a
suffix.

Note: If the source file is a TXLF file, no copy is
saved.

Create Folder with language suffix next to the
Source File where TXLF file will be stored

Click to create a TXLF copy of the source file in a
source file sub-folder using the target language code
as a suffix.

Note: If the source file is a TXLF file, no copy is
saved.

 5. Select the Quick Project Options to show the Open TXLF choices dialog during the process of creating a
Quick Project. Refer to

 6. Select columns to include in the Get MS Word Table Options, then set the tag mode.
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Option Action

Segment ID Select to include the Segment ID column in the MS
Word table.

Source Select to include the Source column in the MS Word
table.

Score Select to include the Score column in the MS Word
table.

Set Tag mode to: Select the tag mode from the drop-down list.

• Show supported text formatting

• Show formatting as Tags

• Do not show Tags

 7. Select the Bilingual Review Export options to export a file with highlighted glossary terms in a Microsoft
Word .DOC or .DOCX format.

Option Action

Open report after export Select to automatically open the Bilingual Report after
the export completes.

Exclude the notes column Select to exclude the notes column from the exported
MS Word document.

Track changes Select to enable track changes in the exported MS
Word document.

Protect document (Word 2003+) Select to write-protect the document. This allows
users to edit only the target segment content and add
notes.

Export all TXLF files as one bilingual file Select to export all submission files as a single
bilingual file.

Export as Docx Select to export the bilingual report in the
Word .DOCX file format.

 8. Select the option to display the dialog for running Quick Tools analysis and cleanup as batch actions that run
in the background.

 9. Set the search depth when using the remote TM for your connected TM server type.

 10. To automatically provide Live Preview when opening a file in the TXLF Editor view for source MS Word .DOC
and .DOCX or MS Powerpoint .PPT and .PPTX file formats, enable the Live Preview option.

GENERAL PREFERENCES

Configure Fonts
Fonts preferences control customization of font type and size for application-wide functions, such as notes.
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To configure fonts:

 1. Select Preferences from the Wordfast drop-down menu.

 2. Click Fonts under General Preferences.

 3. Select an application-specific font and size for an item name, such as Segment History Font.

 4. Click Change.

 5. (Optional) Preview the impact of your change in the Preview pane.

 6. Select a language-specific font.

 7. Add, remove, or change the language-specific font

 8. Click OK.

GENERAL PREFERENCES

Configure Icon Settings
Icons preferences control the relative size of the icon and include or exclude the icon title.

To configure icon settings:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Icons under General Preferences.
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 3. Select a size for application icons.

 4. (Optional) Deselect Display text to exclude icon description text.

 5. Click OK.

GENERAL PREFERENCES

Configure Layout Options
Layout preferences control the arrangement of user interface views.

To configure layout options:

 1. Select Preferences from the Wordfast drop-down menu.

 2. Click Layout under General Preferences.
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 3. (Optional) Modify the Table View layout to hide or show columns and headers.

 4. (Optional) Modify the TM Score Column Position layout for before or after the target column.

 5. (Optional) Modify the Current Project layout to include the target language name or use a language code in
the view.

 6. (Optional) Modify the Status Bar Representation layout in the Current Project view.

Language Codes Click to include language codes on the Status Bar.

Full Language Name Click to include the complete language name on the Status Bar.

 7. Click OK.

GENERAL PREFERENCES

Configure Segment Actions
Segment Actions preferences control segment action behaviors, such as Smart Quotes or Smart Punctuation.

To configure segment actions:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Segment under General Preferences.



12. Configure Preferences Wordfast

Copyright © Wordfast, LLC 2018.   Page 150 of 210

 3. Select a segment option.

Option Action

Next/Previous Segment action
leverages next/previous segment

Select to automatically leverage the TM for the segment as you
make the segment active.

Open last edited segment when
opening a file

Select to go to the last segment edited after reopening a file.

Leverage the first opened segment
on click

Select to automatically leverage the TM for the first open segment
you click after opening a file for translation.

Capitalize the first letter of the target
segment (Except Asian Languages)

Select to convert translated segments to sentence case. Not
applicable for Asian languages.
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Option Action

Enable Smart Quotes Select to activate both Smart Quote and Smart Punctuation
features.

• Smart Quotes — Changes the quotation marks to smart
quotes, depending on the target language.

• Smart Punctuation — Changes white space and
punctuation mark elements to those appropriate for the target
language, with the exception of Chinese, Japanese, and
Korean (CJK) languages and those that read from right-to-
left (RTL), such as Arabic, Hebrew, Persian, and Urdu.

Note: The white space group includes spaces, non-breaking
spaces, and white space representations: the middot and overring.
The white space group also includes cases where an exclamation
point or question mark exists in isolation at the beginning of the
segment, sentence, or paragraph.

Skip Unedited 100% Matches Select to ignore 100% matched segments.

Skip Unedited Context Matches Select to ignore segments with context matches.

Cursor position on segment opening Select to place the cursor at the beginning or end of the active
segment.

• Start — The default places the cursor at the beginning of the
segment on segment selection.

• End— Places the cursor at the end of the segment on
segment selection.

GENERAL PREFERENCES

Customize Keyboard Shortcuts
Shortcuts preferences control keyboard shortcuts for the commands that you frequently use.

To customize keyboard shortcuts:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Shortcuts under General Preferences.
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 3. Select a style Scheme from the drop-down list.

   When changing or creating new shortcut key sequences, the sequence must either begin with a Ctrl,
Alt, or Shift, must use a function key, or use a combination of these.

4. Select a Command from the command list and enter a new sequence of keys in the Shortcut column, then
click OK.

 5. (Optional) If you choose a shortcut key sequence already in use, a warning message notifies you that it will
override the prior key sequence. Click Yes to save the new shortcut for a command.

The new shortcut key sequence is saved.

GENERAL PREFERENCES

Configure Warning Messages
Warnings preferences control the type of warning notifications you receive.

To configure warning messages:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Warnings under General Preferences.
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 3. Select your warning notifications.

 To change the ability to show the Get MS Word Table configuration dialog, select to enable or
disable the Show dialog to configure Get MS Word Table Preferences option.

 4. Click OK.

GENERAL PREFERENCES

Configure Tags and Formatting
Tags and Formatting preferences control the tag mode, representation, and font size in TXLF Editor.

To configure tag and formatting options:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Tags under General Preferences.
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 3. (Optional) Modify Text Formatting options.

Option Action

Show supported text
formatting

Click to display formatted content in TXLF Editor view, along with a
sample of the formatted content in Preview.

Show formatting as Tags Click to display content with formatting tags in TXLF Editor view, along
with a sample of the formatted content and tags in Preview.

 4. (Optional) Modify Tag Naming options.

Option Action

Full Name Click to view the tag's full name, for example Font.

Short Name Click to view the tag's short name, for example F.

Numbered Tags Click to view the tag's number, for example 3.

Remove incomplete tag pairs Select to delete incomplete or incorrect tags from the file.

Apply source segment
formatting to target segment

Select to apply segment formatting within a tag from the source segment
to the target segment.

GENERAL PREFERENCES

Configure Auto-Propagation
Auto-Propagation preferences control the automatic update of content with specified types of TM matches.
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To configure auto-propagation:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Auto-Propagation under General Preferences.

 3. Select Enable Auto-Propagation for repetitions to activate additional auto-propagation options (default).

 4. (Optional) Select Enable Auto-Propagation across all open files to apply auto-propagation to all files that
are open.

 5. Select your Auto-Propagation options.

Option Action

Context matches Select to overwrite context leveraged translation memory (TM) matches.

100% matches Select to overwrite 100% leveraged TM matches (default).

Fuzzy matches Select to overwrite partial TM matches (default).

Auto-propagated
matches

Select to overwrite all auto-propagated matches (default).

Note: If there are multiple segments that have the same content, editing a
segment auto-propagates the change to all matching segments.

Edited segments Select to overwrite edited segments using Auto-Propagation.

Machine translated
segments

Select to overwrite machine translated content (default).

Committed segments Select to overwrite translated content that is committed to the TM.
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GENERAL PREFERENCES

Configure Auto-Suggestion
Auto-Suggestion preferences control automatic recommendations for source content, such as numbers, URLs,
and proper names. It can also recommend terms for the glossary, Translation Memory (TM) matches, and
machine translation (MT) matches.

To configure auto-suggestion:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Auto-Suggestion under General Preferences.

 3. Select the Enable Auto-Suggestion check box and suggestion options, then click OK.

Option Action

Capitalized source
words

Select for source segment suggestions: numbers and capitalized words only.

Glossary terms Select for glossary suggestions, based on the project.

TM Select for translation suggestions from the TM.

TM sub-segments Select for sub-segment translation suggestions from the TM.

MT Select for machine translation (MT) translation suggestions.
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GENERAL PREFERENCES

Configure and Enable Spellchecker
Spellchecker preferences control the interaction between the application and Microsoft Office, Hunspell, or Bing.
The Hunspell option requires software installation on your computer.

To configure and enable Spellchecker:

 1. Click Spellchecker in the General Preferences group.

 2. Select Enable Spellchecking to enable Spellchecker.

 Deselect Enable Spellchecking to disable Spellchecker. Disabling Spellchecker clears all
Spellchecker preferences. You must reconfigure your preferences when you re-enable Spellchecker.

 3. (Optional) Select Check for spelling errors as you type and configure for Microsoft Office, Hunspell, or Bing,
based on your installation.

 To install Hunspell, go to Help > Wordfast Pro Update, choose the required language JAR, and click
Update. Select Hunspell for any of the following languages after you install it.

Language Code Language Code

Arabic AR Korean (South Korea) KO-KR

Basque (Basque) EU-ES Latvian (Latvia) LV-LV

Bosnian (Bosnia) BS-BA Lithuanian (Lithuania) LT-LT
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Language Code Language Code

Bulgarian (Bulgaria) BG-BG Malaysian (Malaysia) MS-MY

Catalan (Catalan) CA-ES Norwegian (Bokmål Norway) NB-NO

Croatian (Croatia) HR-HR Norwegian (Nynorsk Norway) NN-NO

Czech (Czech Republic) CS-CZ Polish (Poland) PL-PL

Danish (Denmark) DA-DK Portuguese (Brazil) PT-BR

Dutch (Netherlands) NL-NL Portuguese (Portugal) PT-PT

English (Canada) EN-CA Romanian (Romania) RO-RO

English (United Kingdom) EN-GB Russian (Russia) RU-RU

English (United States) EN-US Scottish Gaelic (United Kingdom) GD-GB

Estonian (Estonia) ET-EE Serbian (Serbia) SR-RS

Farsi (Iran) FA-IR Slovak (Slovakia) SK-SK

Finnish (Finland) FI-FI Slovenian (Slovenia) SL-SI

French (Canada) FR-CA Spanish (Mexico) ES-MX

French (France) FR-FR Spanish (Spain) ES-ES

Galician (Spain) GL-ES Swedish (Sweden) SV-SE

German (Germany) DE-DE Swahili (Kenya) SW-KE

Greek (Greece) EL-GR Tagalog (Philippines) TL-PH

Hebrew (Israel) HB-IL Thai (Thailand) TH-TH

Hindi (India) HI-IN Turkish (Turkey) TR-TR

Hungarian (Hungary) HU-HU Ukrainian (Ukraine) UK-UA

Indonesian (Indonesia) ID-ID Urdu UR

Irish (Ireland) GA-IE Vietnamese (Vietnam) VI-VN

Italian (Italy) IT-IT Welsh (United Kingdom) CY-GB

Japanese (Japan) JA-JP Zulu (South Africa) ZU-ZA

Kazakh (Kazakhstan) KK-KZ

 4. Click OK to save your configuration.

GENERAL PREFERENCES

Configure Machine Translation
Machine Translation (MT) preferences control automatic population of target segments with translations that
have no translation memory (TM) segment matches using a machine translation engine.
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To configure machine translation:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Machine Translation under General Preferences.

 3. Select one of the following:

• Show MT results in TM Lookup when there is no TM match, to show machine translated content without
local or remote TM matches.

• Always show MT results in TM Lookup, to show machine translated content with leveraged segments.
TM matches display in TM Lookup with the MT matches.

 4. Select check boxes to allow All unedited segments in active document to be leveraged with MT, and to
Remove MT score from score column when a segment is edited.

 5. Select Enable DeepL Pro, Enable Google Translator, Enable Microsoft Translator, Enable SYSTRAN
Pure Neural Server,or Enable WorldLingo as the primary machine translator. You can enable all five, but
you can only designate one as the primary machine translator.

 6. Select MT options for each machine translator, then perform the designated setup tasks associated with each
machine translator.

 WorldLingo has a limited set of source languages for MT.
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• Arabic

• Chinese Simplified

• Chinese Traditional

• Dutch

• English

• French

• German

• Greek

• Italian

• Japanese

• Korean

• Portuguese

• Russian

• Spanish

• Swedish

Translator Options

Enable DeepL Pro

Enable Google
Translator

Enable Microsoft
Translator
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Translator Options

Enable SYSTRAN
Pure Neural Server

Enable WorldLingo

WorldLingo MT has a limited source language set.

 7. Click Test to validate the connection to the external machine translation provider.

 8. Read the disclaimer and click OK.

Your machine translation preferences are configured.

Current Project Preferences
Current project preference options control settings unique to the project. Either you or your Project Manager can
set project preferences.

 
Settings begin with standard defaults.

CURRENT PROJECT PREFERENCES

Configure TM Content Replacement
Replacement preferences control TM replacement of specified types of content to increase TM match results.
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To enable replacements:

 1. Click Replacement in the New Project Preferences group.

 2. Select Enable replacement of detected text in TM results for higher TM matches, then enable specific
content type replacement options.

 3. Click OK.

CURRENT PROJECT PREFERENCES

Configure a Translation Memory
Translation Memory (TM) preferences control project-level TM behaviors.
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To configure a translation memory (TM):

 1. Click Translation Memory in the New Project Preferences group.

 2. (Optional) Select TM match options.

Option Action

Write 'exact' matches to
TM

Select to commit contextual matches to a TM.

Write 'unedited MT' to
TM

Select to commit unedited machine translated matches to a TM.

Write 'unedited fuzzy' to
TM

Select to commit unedited fuzzy matches to a TM.

Write 'unedited
autopropagated fuzzy'
to TM

Select to commit unedited auto-propagated fuzzy matches to a TM.

Copy source to Target
on no match

Select one of the options to copy specific content components to the target
segment when there is no match during TM leverage.

Fuzzy Match Threshold Select the baseline percentage for TM matches from the drop-down list.

Note: This percentage specifies the TM leverage limit for a fuzzy match. For
example, with a threshold of 75%, all segment translations below a 75% match
are marked as 'No match' segments.

 3. Select Report Settings options.
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 4. (Optional) Select only one TM condition from When Updating an existing TU when editing an existing
translation unit (TU).

 5. (Optional) Select the Total number of TUs shown in TM Lookup pane value.

 6. Click OK.

CURRENT PROJECT PREFERENCES

Configure Terminology
Terminology preferences control terminology lists for leveraging previously translated content.

To select terminology options:

 1. Select Preferences from the Wordfast drop-down menu.

 2. Click Terminology under New Project Preferences.

 3. Select Enable fuzzy term recognition to view fuzzy matches.

 4. Select Enable term highlighting when typing terms to indicate terminology matches by highlight when
entered in the translation.

 5. Select Ignore case for term highlighting to ignore case difference in terminology matches.

 6. Select the number of matches you can view, then click OK.
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CURRENT PROJECT PREFERENCES

Configure TM Penalties
Penalties preferences help maintain a high quality of content leveraged from a translation memory (TM). This
involves assessing a penalty to TM matches to provide a relative score for those TM matches. You can assign
a relative value to each penalty type when calculating the translation score. This score helps users differentiate
between 100% match, fuzzy match, and no match content.

To configure penalties for TM matches:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Penalties under New Project Preferences.

 3. Select a penalty, supply a threshold, then click OK.

Penalty Action

Case Select to consider differences in case.

Non Literal Select to consider differences in special characters, including
punctuation, space, apostrophe, dash, and quote.

Tag Select to consider differences in tagging.

Whitespace Select to consider differences in blank spacing.

Align Select to consider differences in translation units (TUs) with
alignment attributes.
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Penalty Action

Machine
Translation

Select to consider differences in TUs based on machine
translation (MT).

Multiple
Translation

Select to consider differences in TUs based on duplicates within
the TM with different translations.

Local TM Select to consider differences in TUs from the local desktop
copy.

Remote TM Select to consider differences in TUs from a remote TM.

Private TU Select to consider differences in work-group TUs from a remote
TM.

Public TU Select to consider differences in non-work-group TUs from a
remote TM.

Secondary TM Select to indicate that the translation leverages a secondary TM.

Attribute Select to consider differences in attributes.

If attribute is not Select for when a custom attribute in a TU does not match the
text box attribute.

If filename
attribute does not
match

Select for when the file name attribute in a TU does not match
the TXLF file name.

CURRENT PROJECT PREFERENCES

Configure Transcheck
Transcheck preferences control at the project level how Transcheck verifies target segments, and issues
warnings about common translation errors. For example, if a tag is missing or there is incorrect text, a  displays
in the Status column.

To configure Transcheck:

 1. Select Preferences from the Wordfast drop-down menu.

 2. On the Preferences dialog, click Transcheck under New Project Preferences.

 
There are primary Transcheck options, some that provide additional sub-options.
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 3. To control how Transcheck evaluates source and target segments, select different configuration settings.

Option Action

Transcheck segments
while translating

Select to enable Transcheck during translation.

Select/Deselect All Select to enable or disable all Transcheck options. To select only some
Transcheck options, continue down the settings list.

Blacklist Check Select to identify terms in target segments that are banned from use in the
content.

Note: The blacklisted term list must be a tab-delimited file.
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Option Action

Capitalization Check Select to identify differences in capitalization, then select the appropriate check
boxes.

• All Caps Mismatch — Select to identify text in the target that is all upper
case, when the source is not all upper case.

• First Word Case Difference Check — Select to verify the first letter of the
first word is capitalized consistently in source and in target.

• Target Capitalization Mismatch Check — Select to identify upper case
text in the target that is in lower case in the source.

• Source Capitalization Mismatch Check — Select to identify upper case
text in the source that is in lower case in the target.

• Skip exact matches — Select to ignore capitalization on exact matches.

• Skip context matches — Select to ignore capitalization on context
matches.

Edited Context Match
Check

Select to identify if there are edits to context matches from the TM.

Edited Exact Match
Check

Select to identify if there are edits to exact matches from the TM.

Edited Source Check Select to identify if there are edits to the source of a segment.

Empty Target Check Select to identify segments containing no content in the target column.

Forbidden Character
Check

Select to identify target segments containing forbidden characters, such as the
tilde, asterisk, or ampersand.

1. Click Add, enter the forbidden character or character string in the column
1 field, then click Update.

2. Select whether you want to ignore exact matches or context matches.

Mistranslated Text
Check

Select to identify segments with common translation errors. This generates a
report that lists the correct and wrong usage of translated text.

1. Suppress noise — Select to remove redundancy from the reported
warnings or errors.

2. Skip exact matches — Select to ignore common translation errors on
exact matches.

3. Skip context matches — Select to ignore common translation errors on
context matches.

Note Check Select to identify and run a report of segments with notes. When you run
Transcheck while in TXLF Editor, every segment that has notes has a related
alert flag.

• Skip exact matches — Select to ignore notes on exact matches.

• Skip context matches — Select to ignore notes on context matches.
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Option Action

Number Difference
Check

Select to identify numerals in the source segment that match the target segment.

• Treat numbers separated by hyphens and dashes as single number —
Select to ignore hyphenation and dashes separating numbers.

• Skip exact matches — Select to ignore numerals on exact matches.

• Skip context matches — Select to ignore numerals on context matches.

Paragraph Length
Check

Select to identify target paragraph lengths that exceed the maximum character
length set for the paragraph.

Punctuation Check Select to identify consistency in typical punctuation, such as commas or periods,
between source and target segments.

1. Click Add, enter the source punctuation mark in the column 1 field, the
target punctuation mark in the column 2 field, then click Update.

2. Select to include dual occurrences of a punctuation mark, ignore exact
matches, or ignore content matches.

Repeated Word Check Select to identify duplicated words in the translation.

• Skip exact matches—Select to ignore repeated words on exact matches.

• Skip context matches—Select to ignore repeated words on context
matches.

Segment Length Check Select to verify if the translation complies with preset limits on characters and
words.

• Strict Character Length Check (Zero means unlimited) — Select to
identify violations of minimum and maximum character length.

• Character Expansion Check — Select to identify violations of minimum
and maximum character expansion, as a percentage.

• Word Expansion Check — Select to identify violations of minimum and
maximum word expansion, as a percentage.

• Attribute Character Max Length Check — Select to identify violations of
attribute text that exceeds the maximum character length.

• Skip exact matches — Select to ignore segment length on exact
matches.

• Skip context matches — Select to ignore segment length on context
matches.

Smart Punctuation
Check

Select to identify consistency in less common symbols, such as copyright
symbols, trademarks, and bullets, between source and target segments.

• Skip exact matches — Select to ignore extended punctuation on exact
matches.

• Skip context matches — Select to ignore extended punctuation on
context matches.
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Option Action

Copied Source Check Select to identify segments in the target that contains segments copied from the
source.

• Skip exact matches — Select to ignore exact matches of copied source
content.

• Skip context matches — Select to ignore context matches of copied
source content.

• Skip tokens — Select to ignore software tokens within regular expressions
in the copied source, such as [-+_/\[\]()#:;.A-Z0-9]+

Spelling Check Select to employ spell check as you enter the translation.
If the spell check language is not available, a message notifies you that
Transcheck will continue, but the spell check does not take place.

• Skip exact matches — Select to ignore spell check on exact matches.

• Skip context matches — Select to ignore spell check on context matches.

Tag Check Select to identify missing tags in the target segments.

• Check for non-formatting tags

• Check for Source formatting missing in target

• Check for formatting that exists in target but not in source

• Skip exact matches — Select to ignore tags with exact matches.

• Skip context matches — Select to ignore tags with context matches.

Terminology Check Select to determine if the terms in the source segment are translated correctly
based on the terms in the terminology list.

• Enforce Term Case — Select to verify the source text matches the exact
case of the term.

• Fuzzy Term Check — Select to include terms that approximately match
the term.

• Skip exact matches — Select to ignore terms with exact matches.

• Skip context matches — Select to ignore terms with context matches.

Unconfirmed Segment
Check

Select to verify if the segment is marked unconfirmed.

• Skip exact matches — Select to ignore unconfirmed exact match
segments.

• Skip context matches — Select to ignore unconfirmed context match
segments.

Unedited Exact Check Select to determine if exact matches were not edited.

Unedited Fuzzy Check Select to determine if fuzzy matches were not edited.

Unedited MT Check Select to determine if machine translated matches were not edited.



12. Configure Preferences Wordfast

Copyright © Wordfast, LLC 2018.   Page 171 of 210

Option Action

Untranslatable Text
Check

Select to determine if the content that cannot be translated in source and target
segments is consistent.

1. Click Add, enter the untranslatable content in the column 1 field, then click
Update.

2. Enter an untranslatable regular expression in the custom field.
3. Skip exact matches — Select to ignore exact matches of untranslatable

regular expressions.
4. Skip context matches — Select to ignore context matches of

untranslatable regular expressions.

Untranslated Text
Check

Select to determine if any segments are not translated. Typically, this occurs
when you copy the source into the target segment prior to translation, but missed
translating that segment.

• Skip exact matches — Select to ignore untranslated exact match text.

• Skip context matches — Select to ignore untranslated context match text.

Whitespace Check Select to identify mismatched or double white spaces in the target segment.

• Skip exact matches — Select to ignore exact white space matches.

• Skip context matches — Select to ignore context white space matches.

Consistency check
(Project Transcheck
only)

Select to identify potentially inconsistent translations for the Transcheck Report
action on the Project Files tab.
This consistency check only works as part of the Transcheck Report you access
from the Project Files tab. It does not function for Transcheck options within the
TXLF Editor view.

• Ignore Case Sensitive

• Ignore Numbers

• Ignore Tags

• Ignore Whitespace

 4. Click OK.

Transcheck is reconfigured for the current project.

CURRENT PROJECT PREFERENCES

Configure Segmentation
Segmentation preferences control how the TXLF editor separates file content into logical segments for a project.

To select segmentation options:

 1. Select Preferences from the Wordfast drop-down menu.

 2. Click Segmentation under New Project Preferences.
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 3. Select Segmentation on break to enable segmentation on line breaks.

 4. Select APPLICATION or SRX from the Segmentation Type drop-down list.

 5. Define the end-of-segment marker (ESM) characters.

1. (Optional) Enter specific characters into the ESM field to specify custom segment end characters.
2. (Optional) Select checkboxes for any additional end-of-segment markers.

 6. Select the rules you want for ending segments.

 7. Select a language from the drop-down list. The default language is US English.

 8. (Optional) Enter abbreviations you want to ban during the segmentation process, separated by commas.

 9. (Optional) Enter and review sample text to test your configuration.

 10. Click OK.

CURRENT PROJECT PREFERENCES

Configure File Format Filters
Filters preferences control the file format filters for importing source content to Wordfast Pro.
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To configure file format filters:

 1. Select Preferences from the Wordfast drop-down menu.

 2. Click Filters under New Project Preferences.

 3. Select a filter configuration from the Extract numbers drop-down list to define the filter action on source
segments that contain only numbers.

all Extracts all segments with only numbers for translation

time_date_measure Extracts only segments with time and date

none Does not extract any segments that contain only numbers

 4. To select the file filter settings for the open project, click a filter to list the current settings in the Format
Settings pane.

 5. (Optional) Change settings in the Format Settings pane. The options are specific to the file filter you select.

 6. (Optional) Add a custom file filter for a filter you need that is not already in the list by clicking Add.
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 7. On the New Filter dialog, select a format from the Choose file format drop-down list to use as a template for
the new filter.

 8. Enter a filter name in the Filter Name field, then verify your configuration is correct in the Format Settings
pane.

 9. (Optional) Browse for and select a Fontmapping file, if it is an option for that file format.

 10. Click OK.

User Preferences
You can manage your user preferences, including restoring them to the default state and exporting or importing
them.

USER PREFERENCES

Configure Advanced Settings
Advanced Settings preferences control the means to restore a Wordfast Pro installation to factory or default
settings, migrate preferences between computers, and customize strings.
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To configure advanced settings:

 1. Click Advanced Settings in the User Preferences group.

 2. (Optional) Restore the Default Settings by either clicking Restore Original, based on original settings at the
time of installation, or Restore Defaults, based on default preferences.

 
This action removes all projects, TMs, and glossaries in the Wordfast Pro installation.

 3. (Optional) To set export and import preferences, click Export or Import to apply export or import settings
values to user preferences.

• On the Export dialog, select all or some of the preferences settings, browse and select a file name and
location, then click Export.

• On the Import dialog, browse and select the exported preferences file name and location, select all or
some of the preferences settings, then click Import.

 4. (Optional) Click , type an option in the Customization String List field, then click OK.

 5. Click OK.

The configuration is complete.
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13. Appendix

Accented Characters for Windows
The application supports accented characters for many language sets: those accents combined with standard
characters and those that are autonomous ligatures.

  The key combinations identified here are for use with Windows operating systems and do not pertain
to Mac OS.

Many accents combine with standard characters.

Accent Sample Key Combination Notes

Acute ó or Ó Ctrl+', v
Ctrl+', Shift+V

' is the apostrophe key
v is a lower case vowel
V is an upper case vowel

Circumflex ô or Ô Shift+Ctrl+^, v
Shift+Ctrl+^, Shift+V

v is a lower case vowel
V is an upper case vowel

Grave ò or Ò Ctrl+`, v
Ctrl+`, Shift+V

v is a lower case vowel
V is an upper case vowel

Tilde ñ or Ñ Shift+Ctrl+~, c
Shift+Ctrl+~, Shift+C

~ is the tilde key
c or C is a character, but only works with upper
and lower case N, O, or A

Umlaut ö or Ö Shift+Ctrl+:, v
Shift+Ctrl+:, Shift+V

: is the colon key
v is a lower case vowel
V is an upper case vowel

Other accents require incorporation with the individual characters, so are treated as a complete character.

Complete
Character

Name Key Combination Notes

¡ Inverted exclamation
point

Alt+Shift+Ctrl+! Press and hold all three keys simultaneously

¿ Inverted question mark Alt+Shift+Ctrl+? Press and hold all three keys simultaneously

ç or Ç French C cedilla Ctrl+, , c
Ctrl+, , Shift+C

Press Control and the comma key, release both
keys, then press C or press and hold Shift+C

œ or Œ OE ligature Shift+Ctrl+&, o
Shift+Ctrl+&, Shift+O

Press and hold Shift+Ctrl+&, release the keys,
and press O or press and hold Shift+O

ß German sharp or
double S

Shift+Ctrl+&,s Press and hold Shift+Ctrl+&, release the keys,
and press S

ø or Ø Nordic O slash Ctrl+/, o
Ctrl+/, Shift+O

Press and hold Ctrl+/, release both keys, and
press O or press and hold Shift+O
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Complete
Character

Name Key Combination Notes

å or Å Nordic A-ring,
Angstrom sign

Shift+Ctrl+@, a
Shift+Ctrl+@, Shift+A

Press and hold Shift+Ctrl+@, release the keys,
and press A or press and hold Shift+A

æ or Æ Old English AE ligature Shift+Ctrl+&, a
Shift+Ctrl+&, Shift+A

Press and hold Shift+Ctrl+&, release the keys,
and press A or press and hold Shift+A

ð or Ð Icelandic or Old English
eth

Ctrl+', d
Ctrl+', Shift+D

' is the apostrophe key
Press and hold Ctrl+', release both keys, and
press D or press and hold Shift+D

To insert accents or accented characters:

 1. (Optional) To enter a character that combines with an accent, follow the key combinations in the accent table.

• For example, to create an A with an acute ligature, hold down the Control key and press the apostrophe
key. Release both keys and either press A or press and hold Shift+A.

• For example, to create an O with the grave ligature, hold down the Control key and press the
apostrophe key. Release both keys and either press the O or press and hold Shift+O.

 2. (Optional) To enter a complete accented character, follow the key combinations in the complete character
table.

• For example, to create the inverted exclamation point, press and hold Alt+Shift+Ctrl+!, then release all
keys.

• For example, to create the œ ligature, first press and hold Shift+Ctrl+&, then release the keys and
either press O or press and hold Shift+D.

Formatting Tools
The Formatting tab in the TXLF Editor includes formatting tools you can use to edit the target content format.

Formatting tools fall into three categories: format, tags, and options.

FORMATTING TOOLS

Format

 
Format category options are only available for MS Office source file formats.

Button Keyboard Shortcut Description

Ctrl+B Format the selected text as bold.

Ctrl+I Format the selected text as italic.
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Button Keyboard Shortcut Description

Ctrl+U Format the selected text as underlined.

Ctrl+= Format the selected text as subscript.

Ctrl+Shift+= Format the selected text as superscript.

No shortcut Format the selected text to display as strikethrough
(deleted), without actually deleting the text.

FORMATTING TOOLS

Tags

Button Keyboard Shortcut Description

No shortcut Display actual formatting associated with tags for the
active segment (when supported.)

No shortcut Display the content of the formatting tags for the active
segment.

FORMATTING TOOLS

Options

Button Keyboard Shortcut Description

Ctrl+Shift+Space Insert a non-breaking space at the cursor location.

No shortcut Insert a marker to indicate left-to-right reading direction.

No shortcut Insert a marker to indicate right-to-left reading direction.

Ctrl+D Attach and detach the Formatting toolbar. When
attached, the toolbar is displayed as a tab. When
detached, the toolbar is displayed as a minimized
toolbar that can be moved to any area of the TXLF
Editor.
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Keyboard Shortcuts
This topic includes the keyboard shortcuts that are available for PC and Apple users for Wordfast Pro, Wordfast
Classic, SDLX, and Trados.

KEYBOARD SHORTCUTS

PC Scheme: Wordfast Pro Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist Alt+C Project

Add Glossary Alt+O Project

Add Note Alt+Shift+N Editor

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools

Add Term Ctrl+Alt+T Editor

Add TM Ctrl+N Project

Analyze Ctrl+Space Editor

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear all tags (Segment) Ctrl+Shift+V Editor

Clear Target Document Alt+Shift+Delete Editor

Clear Target Segment Ctrl+Alt+X Editor

Close Ctrl+W Editor

Close project from home window Ctrl+Shift+X Home

Close segment Esc Editor

Commit All Segments to TM Ctrl+Alt+End Editor

Commit Current Segment Alt+End Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy Ctrl+C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Document) Alt+Shift+P Editor

Copy All Tags (Segment) Alt+A Editor
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Commands Shortcut View

Copy selected text to target Alt+F12 Editor

Copy Source Alt+S Editor

Copy Tag Ctrl+Alt+Down Editor

Copy Term Ctrl+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blacklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+- Editor

Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor

Delete Note Alt+Shift+D Editor

Edit Note Alt+Shift+E Editor

Edit Term Ctrl+E Editor

Export Blacklist Alt+K Project

Export Glossary Alt+E Project

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Get Bilingual Table Ctrl+Alt+P Editor

Go To Segment Ctrl+G Editor

Help Ctrl+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist Alt+J Project

Import Glossary Alt+I Project

Import TM Ctrl+Shift+I Project

Insert a cent sign Ctrl+; Editor

Insert Copyright Symbol Ctrl+Alt+C Editor

Insert Ellipsis Ctrl+Alt+. Editor

Insert em dash Alt+Shift+- Editor

Insert en dash F10 Editor

Insert non-breaking hyphen Ctrl+Shift+- Editor

Insert non-breaking space Ctrl+Shift+Space Editor

Insert Registered Trademark
symbol

Ctrl+Alt+R Editor
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Commands Shortcut View

Italic Ctrl+I Editor

Key Assist Panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage Previous TU Alt+Left Editor

Leverage the first TM Lookup
match

Alt+1 Editor

Leverage the second TM
Lookup match

Alt+2 Editor

Leverage the third TM Lookup
match

Alt+3 Editor

Leverage the fourth TM Lookup
match

Alt+4 Editor

Leverage the fifth TM Lookup
match

Alt+5 Editor

Leverage the sixth TM Lookup
match

Alt+6 Editor

Leverage the seventh TM
Lookup match

Alt+7 Editor

Leverage the eighth TM Lookup
match

Alt+8 Editor

Leverage the Next TU Alt+Right Editor

Machine Translate Ctrl+Shift+M Editor

Merge Segments Alt+Page_Down Editor

Modify Alt+M Project

Modify TM Ctrl+Shift+T Project

Move the cursor between the
source and the target

Shift+Tab Editor

Next Segment (Commit to TM) Alt+Down Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+9 Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project
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Commands Shortcut View

Open Project Ctrl+Shift+P Home

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) Ctrl+Up Editor

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctrl+Alt+Left Editor

Previous Term Ctrl+8 Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Quick Tools Alt+Q Home

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Run Transcheck Ctrl+Shift+Q Editor

Save Ctrl+S Editor

Save As F12 Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home

Source TM Lookup Ctrl+Shift+F Editor

Spell Check F7 Editor

Split Segment Alt+Page_Up Editor

Strikethrough Ctrl+K Editor

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance F8 Editor

Toggle uppercase/lowercase Shift+F3 Editor
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Commands Shortcut View

Translate All Ctrl+Shift+End Editor

Translate File Ctrl+O Project

Translate Until Fuzzy Ctrl+Alt+F Editor

Translate Until No Match Ctrl+Shift
+Page_Down

Editor

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+Z Blacklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment Ctrl+Alt+V Editor

KEYBOARD SHORTCUTS

PC Scheme: Wordfast Classic Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist Alt+C Project

Add Glossary Alt+O Project

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools

Add Reference Files Alt+1 Project

Add Term Ctrl+Alt+T Editor

Add TM Ctrl+N Project

Analyze Ctrl+Space Quick Tools

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear Target Document Alt+Shift+Delete Editor

Clear Target Segment Ctrl+Alt+X Editor

Close project from home window Ctrl+Shift+X Home

Commit All Segments to TM Ctrl+Alt+End Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy Ctrl+C Blacklist Editor, TM Editor, Glossary Editor, Editor
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Commands Shortcut View

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Segment) Alt+P Editor

Copy Source Alt+Insert Editor

Copy Tag Alt+Shift+Down Editor

Copy Tag Ctrl+Alt+Down TM Editor

Copy Term Ctrl+Alt+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blacklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+- Editor

Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor

Export Blacklist Alt+K Project

Export Glossary Alt+E Project

Export Package Ctrl+E Home

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Go To Segment Ctrl+G Editor

Help Ctrl+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist Alt+J Project

Import Glossary Alt+I Project

Import TM Ctrl+Shift+I Project

Insert non-breaking space Ctrl+Shift+Space Editor

Italic Ctrl+I Editor

Key Assist Panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage Previous TU Alt+Left Editor

Leverage the Next TU Alt+Right Editor

Merge Segments Alt+Page_Down Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home
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Commands Shortcut View

Modify TM Ctrl+Shift+T Project

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+Alt+9 Editor

Next Update Alt+Down Blacklist Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open Reference Files Alt+2 Project

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctrl+Alt+Left Editor

Previous Term Ctrl+Alt+8 Editor

Pseudo translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Project Ctrl+Alt+R Home

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove tag Ctrl+Alt+Up Editor

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Save Ctrl+S Editor

Save As F12 Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home

Spell Check F7 Editor
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Commands Shortcut View

Split Segment Alt+Page_Up Editor

Strikethrough Ctrl+K Editor

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance Ctrl+Shift+F Editor

Translate File Ctrl+O Project

Translate Until Fuzzy Ctrl+Alt+F Editor

Translate Until No Match Ctrl+Shift
+Page_Down

Editor

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+Z Blacklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment Ctrl+Alt+V Editor

KEYBOARD SHORTCUTS

PC Scheme: SDLX Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist Alt+C Project

Add Glossary Alt+O Project

Add Note Alt+Shift+N Editor

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools

Add Term Ctrl+Alt+T Glossary Editor

Add Term Ctrl+T Editor

Add TM Ctrl+N Project

Analyze Ctrl+Space Editor

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear Target Document Alt+Shift+Delete Editor
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Commands Shortcut View

Clear Target Segment Ctrl+Alt+X Editor

Close Ctrl+Shift+W Editor

Close project from home window Ctrl+W Home

Commit All Segments to TM Alt+End Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy Ctrl+C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Document) Alt+Shift+P Editor

Copy All Tags (Segment) Alt+P Editor

Copy selected text to target Alt+F12 Editor

Copy Source F4 Editor

Copy Tag Ctrl+Alt+Down Editor

Copy Term Ctrl+Alt+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blacklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage F8 Editor

Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor

Delete Note Alt+Shift+D Editor

Edit Note Alt+Shift+E Editor

Edit Term Ctrl+E Editor

Export Blacklist Alt+K Project

Export Glossary Alt+E Project

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Go To Segment Ctrl+L Editor

Help Ctrl+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist Alt+J Project
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Commands Shortcut View

Import Glossary Alt+I Project

Import TM Ctrl+Shift+I Project

Insert copyright symbol Ctrl+Alt+C Editor

Insert ellipsis F11 Editor

Insert em dash Ctrl+F10 Editor

Insert en dash F10 Editor

Insert non-breaking hyphen Ctrl+F9 Editor

Insert non-breaking space Ctrl+Shift+Space Editor

Insert Registered Trademark
symbol

Ctrl+Alt+R Editor

Italic Ctrl+I Editor

Key assist panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage previous TU Alt+Left Editor

Leverage the first TM Lookup
match

Alt+1 Editor

Leverage the second TM
Lookup match

Alt+2 Editor

Leverage the third TM Lookup
match

Alt+3 Editor

Leverage the fourth TM Lookup
match

Alt+4 Editor

Leverage the fifth TM Lookup
match

Alt+5 Editor

Leverage the 6th TM Lookup
match

Alt+6 Editor

Leverage the 7th TM Lookup
match

Alt+7 Editor

Leverage the 8th TM Lookup
match

Alt+8 Editor

Leverage the Next TU Alt+Right Editor

Machine Translate Ctrl+Shift+F8 Editor

Merge Segments Ctrl+J Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home
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Commands Shortcut View

Modify TM Ctrl+Shift+T Project

Move the cursor between the
source and the target

Shift+Tab Editor

Next Segment (Commit to TM) Alt+Down Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+Alt+9 Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) Ctrl+Up Editor

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctrl+Alt+Left Editor

Previous Term Ctrl+Alt+8 Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove Tag Ctrl+Alt+Up Editor

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Run Transcheck F12 Editor

Save Ctrl+S Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home
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Commands Shortcut View

Source TM Lookup Ctrl+Shift+F Editor

Spell Check F6 Editor

Split Segment Ctrl+Enter Editor

Strikethrough Ctrl+K Editor

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance F7 Editor

Toggle uppercase/lowercase Shift+F3 Editor

Translate All Ctrl+Shift+End Editor

Translate File Ctrl+O Project

Translate Until Fuzzy Ctrl+Alt+F Editor

Translate Until No Match Ctrl+Shift
+Page_Down

Editor

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+Z Blacklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment Ctrl+Alt+V Editor

KEYBOARD SHORTCUTS

PC Scheme: Trados Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist Alt+C Project

Add Glossary Alt+O Project

Add Project TMs Ctrl+Shift+B Quick Tools

Add Reference Files Alt+1 Project

Add Term Ctrl+Alt+T Glossary Editor

Add Term Ctrl+F11 Editor

Add TM Ctrl+N Project

Analyze Ctrl+Space Quick Tools
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Commands Shortcut View

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear Target Document Alt+Shift+Delete Editor

Clear Target Segment Ctrl+Alt+X Editor

Close Ctrl+W Editor

Close project from home window Ctrl+Shift+X Home

Commit All Segments to TM Ctrl+Shift+U Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy Ctrl+C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Tags (Segment) Alt+P Editor

Copy selected text to target Alt+F12 Editor

Copy Source F4 Editor

Copy Tag Ctrl+F4 Editor

Copy Term Ctrl+Alt+Down Editor

Copy TM Ctrl+Shift+C Project

Create Blacklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+Space Editor

Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor

Export Blacklist Alt+K Project

Export Glossary Alt+E Project

Export Package Ctrl+E Home

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Go To Segment Ctrl+L Editor

Help Ctrl+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist Alt+J Project

Import Glossary Alt+I Project

Import TM Ctrl+Shift+I Project
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Commands Shortcut View

Insert en dash F10 Editor

Insert non-breaking space Ctrl+Shift+Space Editor

Italic Ctrl+I Editor

Key Assist Panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Machine Translate Ctrl+Shift+F8 Editor

Merge Segments Ctrl+J Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home

Modify TM Ctrl+Shift+T Project

Move the cursor between the
source and the target

Shift+Tab Editor

Next Segment (Commit to TM) Enter Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right TM Editor

Next Update Alt+Down Blacklist Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open Reference Files Alt+2 Project

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Tag Ctrl+Alt+Left Editor

Previous Update Alt+Up Blacklist Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Project Ctrl+Alt+R Home

Remove Reference Files Alt+0 Project
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Commands Shortcut View

Remove Report Alt+Z Project

Remove TM Ctrl+Shift+R Project

Save Ctrl+S Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home

Source TM Lookup Ctrl+Shift+F Editor

Spell Check F6 Editor

Split Segment Alt+S Editor

Strikethrough Ctrl+K Editor

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance F7 Editor

Translate All Ctrl+Shift+A Editor

Translate File Ctrl+O Project

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+Z Blacklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment Ctrl+Alt+V Editor

KEYBOARD SHORTCUTS

Mac Scheme: Wordfast Pro Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist ⌥C Project

Add Glossary ⌥O Project

Add Note ⌥⇧N Editor

Add Project ⌘⇧A Home

Add Project TMs ⌘⇧B Quick Tools

Add Term ⌘⌥T Editor
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Commands Shortcut View

Add TM ⌘N Project

Analyze ⌘Space Editor

Attach/Detach Toolbar ⌘D Editor

Bold ⌘B Editor

Clear all tags (Segment) ⌘⇧V Editor

Clear Target Document ⌥⇧⌦ Editor

Clear Target Segment ^⌥X Editor

Close ⌘W Editor

Close project from home window ⌘⇧X Home

Close segment ⎋ Editor

Commit All Segments to TM ⌘⌥↘⎋ Editor

Commit Current Segment ⌥↘⎋ Editor

Confirm/Unconfirm Segment ⌥↩⎋ Editor

Confirm All Segments ⌘⇧↩⎋ Editor

Copy ⌘C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources ⌘⌥Insert Editor

Copy All Tags (Document) ⌥⇧P Editor

Copy All Tags (Segment) ⌥A Editor

Copy selected text to target ⌥F12 Editor

Copy Source ⌥S Editor

Copy Tag ⌘⌥↓ Editor

Copy Term ⌘0 Editor

Copy TM ⌘⇧C Project

Create Blacklist ⌥B Project

Create Glossary ⌥N Project

Create TM ⌘⇧N Project

Current Segment Leverage ⌥Q Editor

Cut ⌘X Blacklist Editor, TM Editor, Glossary Editor, Editor

Delete Note ⌥⇧D Editor

Edit Note ⌥⇧E Editor

Edit Term ⌘E Editor

Export Blacklist ⌥K Project

Export Glossary ⌥E Project
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Commands Shortcut View

Export Report as PDF format ⌥U Project

Export TM ⌘⇧E Project

Find/Replace ⌘F Editor

Get Bilingual Table ⌘⌥P Editor

Go To Segment ⌘G Editor

Help ⌘⌥H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist ⌥J Project

Import Glossary ⌥I Project

Import TM ⌘⇧I Project

Insert a cent sign ⌘; Editor

Insert copyright symbol ⌘⌥C Editor

Insert ellipsis ⌘⌥. Editor

Insert em dash ⌥- Editor

Insert en dash ⌥⇧- Editor

Insert non-breaking hyphen ⌘⇧- Editor

Insert non-breaking space ⌘⇧Space Editor

Insert Registered Trademark
symbol

⌘⌥R Editor

Italic ⌘I Editor

Key Assist Panel ⌘⇧L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment ⇧F5 Editor

Leverage Previous TU ⌘← Editor

Leverage the first TM Lookup
match

⌥1 Editor

Leverage the second TM
Lookup match

⌥2 Editor

Leverage the third TM Lookup
match

⌥3 Editor

Leverage the fourth TM Lookup
match

⌥4 Editor

Leverage the fifth TM Lookup
match

⌥5 Editor

Leverage the sixth TM Lookup
match

⌥6 Editor
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Commands Shortcut View

Leverage the seventh TM
Lookup match

⌥7 Editor

Leverage the eighth TM Lookup
match

⌥8 Editor

Leverage the Next TU ⌘→ Editor

Machine Translate ⌘⇧M Editor

Merge Segments ⌥⇟ Editor

Modify ⌥M Project

Modify TM ⌘⇧T Project

Move the cursor between the
source and the target

⇧⇥ Editor

Next Segment (Commit to TM) ⌥↓ Editor

Next Segment (No Commit) ⌘↓ Editor

Next Tag ⌘⌥→ Editor

Next Term ⌘9 Editor

Next View ⌥W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist ⌥H Project

Open Glossary ⌥G Project

Open Project ⌘⇧P Home

Open TM ⌘⇧G Project

Paste ⌘V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) ⌘↑ Editor

Previous Segment (TM Commit) ⌥↑ Editor

Previous Tag ⌘⌥← Editor

Previous Term ⌘8 Editor

Pseudo Translate ⌘⇧Y Quick Tools

Redo ⌘Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ⌥R Project

Remove Reference Files ⌥0 Project

Remove Report ⌥Z Project

Remove TM ⌘⇧R Project
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Commands Shortcut View

Replace/Find ⌘H Editor

Run Transcheck ^Q Editor

Save ⌘S Editor

Save As F12 Editor

Save File As Translated ⌘⌥S Editor

Show White Space Characters ⌘⇧8 Editor

Simple Project Creator ⌘P Home

Source TM Lookup ⌘⇧F Editor

Spell Check F7 Editor

Split Segment ⌥⇞ Editor

Strikethrough ⌘K Editor

Subscript ⌘= Editor

Superscript ⌘⇧= Editor

Term Info ⌥T Editor

Terminology Highlight ⌘F5 Editor

TM Concordance F8 Editor

Toggle uppercase/lowercase ⇧F3 Editor

Translate All ⌘⇧↘⎋ Editor

Translate File ⌘O Project

Translate Until Fuzzy ⌘⌥F Editor

Translate Until No Match ⌘⇧⇟ Editor

Unconfirm All Segments ⌥⇧↩⎋ Editor

Underline ⌘U Editor

Undo ⌘Z Blacklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment ⌘⌥V Editor

KEYBOARD SHORTCUTS

Mac Scheme: Wordfast Classic Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist ⌥C Project

Add Glossary ⌥O Project
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Commands Shortcut View

Add Note ⌥⇧N Editor

Add Project ⌘⇧A Home

Add Project TMs ⌘⇧B Quick Tools

Add Reference Files ⌥1 Project

Add Term ⌘⌥T Editor

Add TM ⌘N Project

Analyze ⌘Space Quick Tools

Attach/Detach Toolbar ⌘D Editor

Bold ⌘B Editor

Clear Target Document ⌥⇧⌦ Editor

Clear Target Segment ^⌥X Editor

Close project from home window ⌘⇧X Home

Commit All Segments to TM ⌘⌥↘⎋ Editor

Confirm/Unconfirm Segment ⌥↩⎋ Editor

Confirm All Segments ⌘⇧↩⎋ Editor

Copy ⌘C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources ⌥⇧Insert Editor

Copy All Tags (Segment) ⌥P Editor

Copy Source ⌥Insert Editor

Copy Tag ⌘⌥↓ TM Editor

Copy Tag ⌥⇧↓ Editor

Copy Term ⌘⌥0 Editor

Copy TM ⌘⇧C Project

Create Blacklist ⌥B Project

Create Glossary ⌥N Project

Create TM ⌘⇧N Project

Current Segment Leverage ⌥Q Editor

Cut ⌘X Blacklist Editor, TM Editor, Glossary Editor, Editor

Delete Note ⌥⇧D Editor

Edit Note ⌥⇧E Editor

Edit Term ⌘E Editor

Export Blacklist ⌥K Project

Export Glossary ⌥E Project
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Commands Shortcut View

Export Package ⌘E Home

Export Report as PDF format ⌥U Project

Export TM ⌘⇧E Project

Find/Replace ⌘F Editor

Go To Segment ⌘G Editor

Help ⌘⌥H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist ⌥J Project

Import Glossary ⌥I Project

Import TM ⌘⇧I Project

Insert non-breaking space ⌘⇧Space Editor

Italic ⌘I Editor

Key Assist Panel ⌘⇧L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment ⇧F5 Editor

Leverage Previous TU ⌘← Editor

Leverage the Next TU ⌘→ Editor

Merge Segments ⌥⇟ Editor

Modify ⌥M Project

Modify Project ⌘⇧M Home

Modify TM ⌘⇧T Project

Next Segment (No Commit) ⌘↓ Editor

Next Tag ⌥⇧→ Editor

Next Term ⌘⌥9 Editor

Next Update ⌥↓ Blacklist Editor

Next View ⌥W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist ⌥H Project

Open Glossary ⌥G Project

Open Project ⌘⇧P Home

Open Reference Files ⌥2 Project

Open TM ⌘⇧G Project

Paste ⌘V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
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Commands Shortcut View

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (TM Commit) ⌥↑ Editor

Previous Tag ⌘⌥← Editor

Previous Term ⌘⌥8 Editor

Pseudo Translate ⌘⇧Y Quick Tools

Redo ⌘Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ⌥R Project

Remove Project ⌘⌥R Home

Remove Reference Files ⌥0 Project

Remove Report ⌥Z Project

Remove tag ⌘⌥↑

Remove TM ⌘⇧R Project

Replace/Find ⌘H Editor

Save ⌘S Editor

Save As F12 Editor

Save File As Translated ⌘⌥S Editor

Show White Space Characters ⌘⇧8 Editor

Simple Project Creator ⌘P Home

Spell Check F7 Editor

Split Segment ⌥⇞ Editor

Strikethrough ⌘K Editor

Subscript ⌘= Editor

Superscript ⌘⇧= Editor

Term Info ⌥T Editor

Terminology Highlight ⌘F5 Editor

TM Concordance ⌘⇧F Editor

Translate File ⌘O Project

Translate Until Fuzzy ⌘⌥F Editor

Translate Until No Match ⌘⇧⇟ Editor

Unconfirm All Segments ⌥⇧↩⎋ Editor

Underline ⌘U Editor

Undo ⌘Z Blacklist Editor, TM Editor, Glossary Editor, Editor
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Commands Shortcut View

Verify Segment ⌘⌥V Editor

KEYBOARD SHORTCUTS

Mac Scheme: SDLX Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist ⌥C Project

Add Glossary ⌥O Project

Add Note ⌥⇧N Editor

Add Project ⌘⇧A Home

Add Project TMs ⌘⇧B Quick Tools

Add Term ⌘T Editor

Add Term ⌘⌥T Glossary Editor

Add TM ⌘N Project

Analyze ⌘Space Editor

Attach/Detach Toolbar ⌘D Editor

Bold ⌘B Editor

Clear Target Document ⌥⇧⌦ Editor

Clear Target Segment ^⌥X Editor

Close ⌘⇧W Editor

Close project from home window ⌘W Home

Commit All Segments to TM ⌥↘⎋ Editor

Confirm/Unconfirm Segment ⌥↩⎋ Editor

Confirm All Segments ⌘⇧↩⎋ Editor

Copy ⌘C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources ⌘⌥Insert Editor

Copy All Tags (Document) ⌥⇧P Editor

Copy All Tags (Segment) ⌥P Editor

Copy selected text to target ⌥F12 Editor

Copy Source F4 Editor

Copy Tag ⌘⌥↓ Editor

Copy Term ⌘⌥0 Editor
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Commands Shortcut View

Copy TM ⌘⇧C Project

Create Blacklist ⌥B Project

Create Glossary ⌥N Project

Create TM ⌘⇧N Project

Current Segment Leverage ⌥Q Editor

Cut ⌘X Blacklist Editor, TM Editor, Glossary Editor, Editor

Delete Note ⌥⇧D Editor

Edit Note ⌥⇧E Editor

Edit Term ⌘E Editor

Export Blacklist ⌥K Project

Export Glossary ⌥E Project

Export Report as PDF format ⌥U Project

Export TM ⌘⇧E Project

Find/Replace ⌘F Editor

Go To Segment ⌘L Editor

Help ⌘⌥H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist ⌥J Project

Import Glossary ⌥I Project

Import TM ⌘⇧I Project

Insert copyright symbol ⌘⌥C Editor

Insert ellipsis F11 Editor

Insert em dash ⌥- Editor

Insert en dash ⌥⇧- Editor

Insert non-breaking hyphen ⌘F9 Editor

Insert non-breaking space ⌘⇧Space Editor

Insert Registered Trademark
symbol

⌘⌥R Editor

Italic ⌘I Editor

Key Assist Panel ⌘⇧L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment ⇧F5 Editor

Leverage Previous TU ⌘← Editor
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Commands Shortcut View

Leverage the first TM Lookup
match

⌥1 Editor

Leverage the second TM
Lookup match

⌥2 Editor

Leverage the third TM Lookup
match

⌥3 Editor

Leverage the fourth TM Lookup
match

⌥4 Editor

Leverage the fifth TM Lookup
match

⌥5 Editor

Leverage the sixth TM Lookup
match

⌥6 Editor

Leverage the seventh TM
Lookup match

⌥7 Editor

Leverage the eighth TM Lookup
match

⌥8 Editor

Leverage the Next TU ⌘→ Editor

Machine Translate ⌘⇧F8 Editor

Merge Segments ⌥J Editor

Modify ⌥M Project

Modify Project ⌘⇧M Home

Modify TM ⌘⇧T Project

Move the cursor between the
source and the target

⇧⇥ Editor

Next Segment (Commit to TM) ⌥↓ Editor

Next Segment (No Commit) ⌘↓ Editor

Next Tag ⌘⌥→ Editor

Next Term ⌘⌥9 Editor

Next View ⌥W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist ⌥H Project

Open Glossary ⌥G Project

Open Project ⌘⇧P Home

Open TM ⌘⇧G Project

Paste ⌘V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
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Commands Shortcut View

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) ⌘↑ Editor

Previous Segment (TM Commit) ⌥↑ Editor

Previous Tag ⌘⌥← Editor

Previous Term ⌘⌥8 Editor

Pseudo Translate ⌘⇧Y Quick Tools

Redo ⌘Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ⌥R Project

Remove Reference Files ⌥0 Project

Remove Report ⌥Z Project

Remove tag ⌘⌥↑ Editor

Remove TM ⌘⇧R Project

Replace/Find ⌘H Editor

Run Transcheck F12 Editor

Save ⌘S Editor

Save File As Translated ⌘⌥S Editor

Show White Space Characters ⌘⇧8 Editor

Simple Project Creator ⌘P Home

Source TM Lookup ⌘⇧F Editor

Spell Check F6 Editor

Split Segment ⌥↩⎋ Editor

Strikethrough ⌘K Editor

Subscript ⌘= Editor

Superscript ⌘⇧= Editor

Term Info ⌥T Editor

Terminology Highlight ⌘F5 Editor

TM Concordance F7 Editor

Toggle uppercase/lowercase ⇧F3 Editor

Translate All ⌘⇧↘⎋ Editor

Translate File ⌘O Project

Translate Until Fuzzy ⌘⌥F Editor

Translate Until No Match ⌘⇧⇟ Editor
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Commands Shortcut View

Unconfirm All Segments ⌥⇧↩⎋ Editor

Underline ⌘U Editor

Undo ⌘Z Blacklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment ⌘⌥V Editor

KEYBOARD SHORTCUTS

Mac Scheme: Trados Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist ⌥C Project

Add Glossary ⌥O Project

Add Project TMs ⌘⇧B Quick Tools

Add Reference Files ⌥1 Project

Add Term ⌘F11 Editor

Add Term ⌘⌥T Glossary Editor

Add TM ⌘N Project

Analyze ⌘Space Quick Tools

Attach/Detach Toolbar ⌘D Editor

Bold ⌘B Editor

Clear Target Document ⌥⇧⌦ Editor

Clear Target Segment ^⌥X Editor

Close ⌘W Editor

Close project from home window ⌘⇧X Home

Commit All Segments to TM ⌘⇧U Editor

Confirm/Unconfirm Segment ⌥↩⎋ Editor

Confirm All Segments ⌘⇧↩⎋ Editor

Copy ⌘C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Tags (Segment) ⌥P Editor

Copy selected text to target ⌥F12 Editor

Copy Source F4 Editor

Copy Tag ⌘F4 Editor

Copy Term ⌘⌥↓ Editor
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Commands Shortcut View

Copy TM ⌘⇧C Project

Create Blacklist ⌥B Project

Create Glossary ⌥N Project

Create TM ⌘⇧N Project

Current Segment Leverage ⌥Q Editor

Cut ⌘X Blacklist Editor, TM Editor, Glossary Editor, Editor

Export Blacklist ⌥K Project

Export Glossary ⌥E Project

Export Package ⌘E Home

Export Report as PDF format ⌥U Project

Export TM ⌘⇧E Project

Go To Segment ⌘L Editor

Help ⌘⌥H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist ⌥J Project

Import Glossary ⌥I Project

Import TM ⌘⇧I Project

Insert en dash ⌥⇧- Editor

Insert non-breaking space ⌘⇧Space Editor

Italic ⌘I Editor

Key Assist Panel ⌘⇧L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment ⇧F5 Editor

Machine Translate ⌘⇧F8 Editor

Merge Segments ⌘J Editor

Modify ⌥M Project

Modify Project ⌘⇧M Home

Modify TM ⌘⇧T Project

Move the cursor between the
source and the target

⇧⇥ Editor

Next Segment (Commit to TM) ↩⎋ Editor

Next Segment (No Commit) ⌘↓ Editor

Next Tag ⌘⌥→ TM Editor

Next Update ⌥↓ Blacklist Editor
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Commands Shortcut View

Next View ⌥W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist ⌥H Project

Open Glossary ⌥G Project

Open Project ⌘⇧P Home

Open Reference Files ⌥2 Project

Open TM ⌘⇧G Project

Paste ⌘V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Tag ⌘⌥← Editor

Previous Update ⌥↑ Blacklist Editor

Pseudo Translate ⌘⇧Y Quick Tools

Redo ⌘Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ⌥R Project

Remove Project ⌘⌥R Home

Remove Reference Files ⌥0 Project

Remove Report ⌥Z Project

Remove TM ⌘⇧R Project

Save ⌘S Editor

Save File As Translated ⌘⌥S Editor

Show White Space Characters ⌘⇧8 Editor

Simple Project Creator ⌘P Home

Source TM Lookup ⌘⇧F Editor

Spell Check F6 Editor

Split Segment ⌥S Editor

Strikethrough ⌘K Editor

Subscript ⌘= Editor

Superscript ⌘⇧= Editor

Term Info ⌥T Editor

Terminology Highlight ⌘F5 Editor

TM Concordance F7 Editor

Translate All ⌘⇧A Editor
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Commands Shortcut View

Translate File ⌘O Project

Unconfirm All Segments ⌥⇧↩⎋ Editor

Underline ⌘U Editor

Undo ⌘Z Blacklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment ⌘⌥V Editor

FAQs
How do I obtain a Wordfast Pro License and install the application?

  When you purchase a Wordfast license, you will receive an installer and a license certificate that
contains login credentials for our website. When you install Wordfast Pro for the first time, it runs in
Demo mode.
When you login to our website using the credentials on your license certificate, enter the provided
activation key in Help > License Management. This will change the Demo mode to a full version.
Refer to Licensure.

What does Wordfast Pro Demo mode mean?

  When in Demo mode, you are limited to creating bilingual projects and storing up to 500 translation
units in your Translation Memory. To get a full version, you must upload a license. Refer to
Licensure.

What happens if I upload a corrupt file for translation when creating a project?

  If one of the files is corrupt or invalid, you can still create a project with clean files. The corrupt or
invalid file will not upload and you receive a warning message.

How do I chain individual files?

  Instead of opening files one-by-one to display in individual tabs, you can chain files to open in a
single tab as long as these files are in the same batch. You cannot chain files across batches.
Chaining files has the following main advantages:

• Open hundreds of files within seconds.

• Filter or search and replace in one pass as opposed to once per individual file.
Refer to Chain Files.

Why is the Analyze button inactive when I open a chained file for translation?

  The Analyze action you can normally access in TXLF Editor view is inactive when you open a
chained file because the translation memory cannot provide the best results.

What are the different ways to analyze files?
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  The analysis process converts source files into TXLF, leverages the content against existing
translation memories, and generates a report listing matches, non-matches, word count, character
count, and segment count. You can analyze source files in the following ways:

• Analyze files within a project on the Project Files tab.

• Analyze any files outside of the project files on the Quick Tools tab.

• Analyze a file open for translation in TXLF Editor view by clicking the Analyze action on the
Translation tab.

Refer to Analysis

How do I use Skip 100% and 100%+ Segments when using TXLF Editor view?

  To skip 100% and 100%+ segments when moving to a segment that requires linguistic changes, you
have two options:

• (Preferred) Set preferences to Skip 100% and 100%+ segments. This allows you to view the
100% and 100%+ segments for context while editing adjacent No Match and Fuzzy match or
MT pre-translations.

• Filter for All except 100% and Context match segments.

How do I share my translation or commit my translation to a TM in real time?

  To share your translation as soon as you finish translating or editing a segment, you must commit it
to the TM. Committing a segment will turn the color highlight from pink to purple. You can commit a
segment to the TM as follows:

• Move to the next segment using ALT + .

• Click Translation > Commit.

• Press Alt+Q.
If a segment does not require any changes, for example, if the 99% match or the MT match is
linguistically correct, you can verify the segment. Verifying the segment will also commit it and turn
the color highlight to purple. You can verify a segment as follows:

• Click the  next to the segment.

• Click Translation > Verify.

• Press Ctrl+Alt+V.
Once the segment is committed to the TM, it becomes a private translation unit (TU) with a penalty
of 1%. As a 99% match, the segment follows 100% matches in the list. Your preliminary translations
go through additional steps such as editing and proofing. Private TUs change to public TUs once you
complete the final linguistic step in the translation workflow. You can automatically leverage a public
TU during analysis at 100% or 100%+.

How do I keep translations from updating the master TM?
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  To prevent a segment from updating the TM:

1. Open the file for translation and click on the segment that you do not want to write to the TM.
2. On the Translation tab, click Unconfirm/Confirm. The Status column displays , and does

not update the TM.
3. To write the segment to the TM, select the segment and click Unconfirm/Confirm again. The

 is removed from the Status column, and the segment may then be updated to the TM.
4. On the Translation tab, click Unconfirm / Confirm All to unconfirm or confirm all segments in

the file.

How do I correctly apply inline formatting?

  You can apply inline formatting to the target segment in two ways:

1. You can enter tag(s) from the source language segment for basic styles such as bold and italic
using the buttons on the Formatting tab. However, these formatting buttons could introduce
tags in the target that do not match the source. Unless the linguist identifies these mismatched
tags using Transcheck and corrects them, they will prevent affected TXLF files from converting
into monolingual files at the align stage.

2. To avoid the mismatched tags, after opening a file for translation, go to Preferences > Tags
and select Show Formatting as Tags.
Since this preference persists from one WFP session to another, you only have to set it once.
This preference enables you to reuse tags from the source using the Copy button under the
Translation tab. If the tag preference is set to Show Text Formatting (when supported), you
must apply formatting using the buttons in the Formatting tab, unless you toggled segment-
by-segment from Tag Formatting to Tag Non-Formatting.

Why is the Whole Words Only check box inactive in Find/Replace dialog?

  In the Find and Replace dialog, the Whole Words Only check box is inactive if you added multiple
words or punctuation to the Find field.

What are Preferences and how do I access them?

  You can customize all user interface options and features using General, Current Project, and User
Preferences groups.
To access preferences, choose one of the following:

• Use the Wordfast Pro tab drop-down menu.

• Use the Projects tab.

• Use the Project Files tab.

• Use the Quick Tools.

• Use the TXLF Editor view.
Refer to Configure Preferences.

How can I preview a file during translation?

  In TXLF Editor, on the File tab, click Preview, then select Live Preview or Office Preview from
the drop-down menu. This opens a document with the target content for comparison to your source
content.
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